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KIRISH

Mamlakatimizda ta’limga e’tibor yildan — yilga ortmogda. Keyingi yillarda
ko plab yangi, zamonaviy kasb — hunar kollejlari, akademik litseylar qurilib ishga
tushirildi, eskilari esa rekonstruktsiya gilindi. Ularning moddiy — texnika bazasi
zamonaviy qurilma va asbob — uskunalar, axborot vositalari bilan jihozlandi.
Prezidentimiz  [.A.Karimov  so’zlari bilan aytganda, “hozirgi axborot,
kommunikatsiya, kompyuter texnologiyalari asrida, internet kundan-kunga
hayotimizning barcha jabhalariga tobora chuqur va keng kirib borayotgan bir paytda,
odamlarning ongi va tafakkuri uchun kurash hal giluvchi ahamiyat kasb etayotgan bir
vaziyatda bu masalalarning jamiyatimiz uchun naqadar dolzarb va ustuvor bo’lib
borayotgani haqgida gapirib o’tirishga hojat yo’q”.!

Davlat ta’lim standartlari talabalariga javob beradigan kadrlar tayyorlash uchun
yangi texnika vositalaridan foydalanish lozim bo’ladi. O qitiladigan fanlar saviyasi
kadrlar saviyasiga juda kata ta’sir etadi. Darhagiqat, Respublikamiz prezidenti
[.A.Karimov ta’kidlaganlaridek, “fanning vazifasi kelajagimizning shakl-shamoyilini
yaratib berish, ertangi kunimizning yo’nalishlarini, tabiily qonuniyatlarini, uning
qanlay bo’lishini ko’rsatib berishdan iborat... Odamlarga mustaqillikning afzalligini,
mustaqil bo’lmagan millatning kelajagi yo’qligini, bu tabiiy bir qonuniyat ekanligini
isbotlab, tushuntirib berish kerak. Fan jamiyat taraqqiyotini olg’a siljituvchi kuch,
vosita bo’lmog’i lozim.”

Har bir fanni o'zlashtirishda ma’ruza mashg ulotlari tayanch hisoblanadi.
Ma’ruzalarni yuqori saviyada tashkil etishda kompyuter imkoniyatlaridan
foydalanishning o'rni katta.

Yangi axborot texnologiyalaridan foydalanib, ma’ruza tayyorlash va oqitish
uslubi, o’kuv jarayoniga kompyuterli o qgitish va nazorat gilish texnologiyalarini
ishlab chiqgish va qo llashning tarkibiy gismi hisoblanadi.

O qgitish va nazorat qilish dasturi tarkibi quyidagicha bo’ladi: ishchi dastur,

elektron o'kuv qo’llanmasi, labaratoriya va amaliy mashg ulotlar uchun metodik

! Karimov I.A. Bizning bosh magsadimiz - jamiyatni demokratlashtirish va yangilash, mamlakatni modernizatsiya va
isloh etishdir. O’zbekiston demokratik taraqqiyotning yangi bosqichida. — Toshkent: O’zbekiston, 2005. — B. 38-39.
2 Karimov I.A. Adolatli jamiyat sari. — Toshkent: O’zbekiston, 1998. — B. 58.




materiallar va topshiriglar, animatsiyali ma’ruzalar, videoslaydlar, test materiallari:
Birinchi kirish ma’ruzasida o°qitish va nazorat gilish dasturi mazmuni,
strukturasi, elementlari va u bilan ishlash uslubi bayon qilinadi. Talabalar tavsiya
gilinayotgan adabiyotlar ro’yxati, ishchi dasturi va baholash mezoni bilan tanishadi.
O qgitish — nazorat gilish dasturi namoyish kilinadi.
Fanning aniq bir mavzusi bo'yicha ma’ruza o°gishning umumiy sxemasi

quyidagicha:

e mavzu nomi va savollar bir paytning o zida ushbu mavzu bo’yicha elektron
ishchi dastur fragmentlari ko rsatilib yetkaziladi;

e ushbu mavzu bo yicha elektron ma’lumotnomasi materiallari ko rsatiladi;

e alohida mavzular bo'yicha videoma’ruzalar ko rsatib — eshittiriladi;

e ma’ruza materiallari videoslaydlar yoki boshga videomateriallar bilan
birgalikda bayon gilinadi;

e talabalarga zarur bo'lganda slaydlar gayta namoyish gilinadi va ma’ruzani
alohida fragmentlari yana tushuntiriladi.

e Bitta yoki bir nechta mavzu o'tib bo'lingach, ochig ko rgazmali xolatda test
sinovlari o tkaziladi.

Ma’ruzaning asosiy gismi — bu materiallarni savol bo'yicha videotasvir
materiallari bilan birgalikda tushuntirishdan iborat. Bu o'rinda ma’ruzachini 0 quv
materialini tushuntirishda videomateriallarni tasvirlashni optimal uyg unlikda olib
borishi muhimdir.

Foydalanilayotgan videomateriallar turlicha bo'lishi mumkin: videoslaydlar,
universal ofisli dasturlar elementlari va vositalari. Videoslaydlar — tushuntirilayotgan
mavzuni ma’ruzachi tomonidan jadval, sxema, diagramma, grafik, matematik ifoda va
modellar shaklida tayyorlanadigan asosiy nazariy holatlari fragmentlaridan tashkil
topadi. Ofis dasturlarining vosita va elementlari — bu turlicha matematik masalalarni
yechishga mo'ljallangan protsedura, funktsiya va boshqalardan iborat.

Ragamli videomateriallardan foydalanib ma’ruza tayyorlash va o°qish,
0 gituvchi — ma’ruzachini malaka darajasiga yuqori talablar go'yadi va uning ishini
jadallashtiradi. Ma’ruzachi ragamli videoslaydlardan foydalanib ma’ruza o qishida
videoslaydlarga material yig ishi, uni ekranda namoyish qilish shaklini aniglashi,




rangli, ovozli va boshqga turdagi samarali multimedialarni kiritishi, tushuntirilayotgan
material matnini videoslayd materiallari bilan optimal uzviyligini ta’minlashi asosiy
elementlarning bir gismi hisoblanadi.

Bu o'rinda yaxlit uslubiy yondashuv mavjud emas, ma’ruzani samarali o tishi,
o0 gitilayotgan fanning o°ziga xos xususiyatlari va o gituvchining malaka darajasiga
bog'lig. Ragamli videotasvir texnika vositalaridan foydalanib ma’ruza o’tishni 0°ziga
xos filmga giyoslasak, ma’ruzachi — o qgituvchi film rejissyori vazifasini bajaradi.
O qgituvchining ishlash sifati oshadi va ishi jadallashadi.

Odatda go’llanilayotgan doskaga yozish, plakatlar, diaproektor uchun slaydlar
va boshga ko'rgazmali vositalardan fargli ravishda, ragamli videoslaydlar na fagat
ma’ruza 0 qish paytida foydalaniladi, shuningdek talabalarga elektron variantlarda
berilishi, ta’lim dargohining namunaviy serveriga Kiritilib masofadan o rganilishi,
ya’ni ular saglanishi, to"ldirilishi, ko paytirilishi ham mumkin bo’ladi.

Ba’zi mavzu va bo'limlarni tushuntirishda nafagat kompyuterlashtirilgan,
shuningdek ma’ruzachi nutqi ham Kiritilgan videoma’ruzalardan foydalanish
mashg ulot sifatini oshiradi. Shuni ham e’tiborga olish lozimki, videoma’ruzalarni
tayyorlash katta mehnat talab giladi va kompyuter resurslariga yuqori talablar qo yadi.
Bundan tashqari biror bir video nutq ma’ruzachini jonli nutgi o rnini bosa olmaydi.
Shu sababli bunday ma’ruzalardan doimiy foydalanish ham magsadga muvofig emas.
Murakkab mavzularni tushuntirishda, yoki mavzuni ba’zi gismlarini tushuntirishda

videoma’ruzalardan foydalanish yaxshi samara beradi.




| Bob. Nazariy gism.

1.1. Elektron ta’lim resurslarini yaratish asoslari

Rivojlangan mamlakatlarda so'ngi yigirma yilda axborot faoliyatining ko'p gismi
bozor infratuzilmasining asosiy elementlaridan bo’lib bozor munosabatlari tarkibiga
singib  ketgan. Axborot-kommunikatsiyalar texnologiyalari bozorining  bozor
infratuzilmasi sifatida shakllanishi 50-yillarning ikkinchi yarmidan boshlandi. Xozirgi
kunda bozorning ushbu tarmog’i xar bir mamlakat milliy igtisodining asosiy negizi
bo’lib hisoblanmogda. Chunki global igtisodiyotni tarkib toptirish uchun zamonaviy
axborot-komunikatsiyalar texnologiyalari infratuzilmasi talab etilmoqgda. Ishbilarmonlik
faoliyatining maqul muxitini shakllantirishda zarur bo’lgan turli axborot, taxliliy
materiallar va ularni tezkor usulda olish axborot-komunikatsiyalar texnologiyalarining
rivojlanib borayotganligi evaziga erishilmoqda.

Mamlakatimizda axborotlashgan jamiyat qurish yo'lidagi asosiy masalalardan
bo'lib axborot maydonining barcha tarkibiy gismlarini rivojlantirish va undagi
boshgaruv sub’ektlari faoliyatini rag batlantirishga garatilgan davlat axborot siyosatini
ishlab chigish hisoblanadi. Axborot-kommunikatsiyalar texnologiyalari bozorini
shakllantirishning ob’ektiv zaruriyatidan kelib chikkan xolda, milliy iktisodning
deyarli barcha tarmoqglari manfaatlariga ta’sir etuvchi keng miqgyosdagi iqdtisodiy,
xuqugiy va siyosiy yechimlarni hal gilishni talab giladigan Uzbekiston Respublikasi
Prezidentining  «Kompyuterlashtirishni ~ yanada  rivojlantirish ~ va  axborot-
kommunikatsiya texnologiyalarini joriy etish to'g risida»gi Farmoni e’lon gilindi. Unda
«...Real iktisodiyot tarmoglari-da, boshgaruv, biznes, fan va ta’lim sohalarida kompyuter
va axborot texnologiyalarini keng joriy etish, axoli turli gatlamlarining zamonaviy
kompyuter va axborot tizimlaridan keng barxamand bo’lishlari uchun shart-sharoitlar
yaratish...» belgilab qoyilgan.

Respublikamiz kutubxona, oliy ta’lim muassasalari, ilmiy-tadkikot institutlari va
vazirliklarida to'plangan katta miqdordagi axborot resurslariga ega. Birog, ushbu
manbalarga integratsiyalashgan xolda kirish usuli xali yo'lga qo'yilmagan. Chunki,
igtisodiy va ijtimoiy rivojlanishning yangi darajasiga o tish, jaxon axborot maxsulotlari

va xizmatlariga chigish yuqorida keltirilgan manbalarga turli axoli guruxlarining tez




suratda Kirib borishini tashkil gilish muammo bo’lib turibdi. Respublikamizda
axborotlar soxasining rivojlanishiga boshga omillarham ta’sir ko rsatmoqgda, jumladan:
jamiyatni axborotlashtirishning past darajadaligi, axborot texnologiyalari rivojlanishi
uchun zarur resurslarning yetarli darajada emasligi, hisoblash texnikasi va aloga
vositalarining yetarli darajada rivojlanmaganligi, EHM lokal va hudud tarmoglarini
go llash va rivojlantirish borasidagi gologlik, texnologiya; ma’lumotlar va bilimlar
bazalarining sust go'llanilishidir.

Jahon amaliyoti tahlili shuni ko rsatmoqdaki, o'z fukorolarini axborotlashgan
muhitda faoliyat ko rsatishga o'rgatgan jamiyatgina vagtdan yutadi, chunki faqat
miqgdoriy ko rsatkichlarga asoslangan igtisodiyot tizimining kelajagi yo'q.

Axborot-kommunikatsiyalar texnologiyalari bozorida asosiy tovar bo’lib
axborot maxsulotlari va xizmatlari sanaladi, ya’ni axborot-kommunikatsiyalar
texnologiyasi yordamida foydalanuvchilarga ko prog. Axborot xizmatini
ko rsatish lozim.

Bozor munosabatlari axborot maxsulotlarining yangiligi, ishonchliligi va
to'ligliga darajalariga yuqori talablar ko'ymoqda. Chunki busiz samarali marketing,
moliya-kredit va investitsiya faoliyatini yuritish mumkin emas. Axborot
maxsulotlarining respublikamiz xayotida to'tgan o'rni va roli ijobiy tomonga
0 zgarib bormogda. Mamlakatimizda axborot-kommunikatsiyalar texnologiyalari
bozori industriyasini tarkib toptirish jamiyatimizda chuqur ijtimoiy o zgarishlarga
olib kelib, uni «industrialdan axborotlashgan jamiyatga» aylantirishiga ishonchimiz
komil.

Axborot va telekommunikatsiyalar bozori AQSH iktisodiy rivojlanishining
asosiy omillaridan bo’lib xizmat kilmokda. Misol uchun, AQSH da jami
iste’molchilar sarflagan xar 10 dollardan 1 dollari ushbu industriya xizmatlari va
maxsulotlariga to'g'ri keladi. Keng ma’noda olganda axborot-kommunikatsiyalar
texnologiyalari bozori AQSH ichki iktisodiy maydonining 10 %ini tashkil etmokda.
Bashorat gilishlaricha, ushbu ko rsatkich yaqin o'n yillikda 20 %ni tashkil etadi.
Agar Xindistonning axborot-kommunikatsiyalar texnologiyalari bozoriga nazar
tashlaydigan bo’lsak, dasturiy maxsulotlar industriyasi un yil oldin 10 min dollarni
tashkil qgilgan bo'lsa, xozirda u 1 mird. dollargacha o'sdi. Mutaxassislarning

bashorat gilishlaricha, ushbu industriyaning daromadi XXI asr boshida 5 mlrd.




dollarni tashkil qildi. Xindistonda dasturiy maxsulotlarni chetga eksport qilish
bo yicha 330ga yagin kompaniyalar faoliyat ko rsatayapti.

Xozirgi kunda jaxon ta’lim  xizmatlari  axborot-kommunikatsiyalar
texnologiyalariga tayangan xolda yo'lga go'yilmokda. Bu borada elektron darslik va
0 quv qo llanmalar katta o’rinni egallamoqda.

Elektron darsliklarni loyixalashtirish, ishlab chigish va o'quv jarayonida
keng foydalanish dolzarb masalalarga aylanmoqda, chunki ular ommaviy ravishda
ta’lim soxasida (o llanila boshlandi. Oxirgi vagtlarda elektron o quv nashrlarning
turli xillari yaratilib, ular 0"z tarkibiga oddiy gipermatn darslikdan tortib masofaviy
o gitishning kompleks tizimlarini gamrab olmoqda.

Elektron darsliklarni quyidagi turlarga ajratish mumkin:

* matnning elektron versiyasi;

« kitobning gipermatnli elektron versiyasi;

« grafik, jadval, rasmlar va gipermatnlar mavjud darslik;

eanimatsiya, ovoz, grafik, jadval, rasmlar va gipermatnlar mavjud darslik;

* animatsiya, ovoz, grafik, jadval, rasm, gipermatnli va test tizimlari mavjud
darsliklar.

Ushbu soxaning yangiligi va o quv-uslubiy ta’minotning yo qligi ishlab
chigilayotgan elektron darsliklarning sifat darajasiga jiddiy ta’sir ko rsatmoqda.
Bundan tashqgari, darsliklarni yaratishning yagona standartlari va dasturiy
vositalarining yo gligi turli ishlab chigaruvchilar tomonidan yaratilgan elektron
darsliklarni o’quv jarayonida samarali qullashga to sginlik gilyapti deyish mumkin.
Shuning uchun ham yaratilayotgan elektron darsliklarning baholash mezonlarini
belgilab olish lozim. Avvalambor, elektron darsliklar o'tilayotgan darslar sifatini
yuksaltirishiga ganday ta’sir ko rsatishini bilish kerak. Elektron darsliklarning
an’anaviy usullarga nisbatan quyidagi afzalliklarini keltirish mumkin:

1.0 quv axborotlarining tagdim etilish shakli.
2.Kerakli axborotlarni gidirish imkoniyati.
3.0lingan bilimlar darajasini nazorat qgilish usullarining mavjudligi.
4. Ogituvchi bilan teskari alokaning mavjudligi
Shulardan kelib chikib, elektron darsliklarni  yaratishning quyidagi

tamoyillarini keltirish mumkin:




e multimedia-ma’lumotlari (matn, grafik, audio,video, animatsiya) asosida
axborotlarni takdim etish;
« gidirish va yo llash imkoniyatlarini Kiritish;
olingan bilimlar darajasini nazorat gilishning ob’ektiv tizimini kiritish;
« tarmog. texnologiyalari asosida o qgituvchi va o quvchining o'zaro interaktiv va
teskari alogasining yo'lga qoyilishi.

O quv materiallarini tagdim etish shakllari

Elektron darsliklardan o'quv jarayonida keng foydalanishning asosiy
muammosi — bu kompyuter ekranidan katta xajmdagi axborotlarni o gishdir. Ushbu
muammoni hal gilish uchun elektron darsliklarni matn va ovoz shaklida taqdim etish
mumkin. Bu ikki usul bitta o'quv materialini turli shaklda tagdim etishi bilan
farklanadi, xolos.

Elektron darslikning matn usulida o quv materiali gipermatn korinishida
taqdim etilib, unda grafik, chizma, diagramma, fotografiya, animatsiya va video
go llaniladi.

Elektron darslik materiali 0" quvchiga diktor ovozi bilan yetkazilib, slayd-shou
ko'rinishdagi material bilan birga beriladi. Audio va videoaxborotlarning o zaro
birgalikda gollanishi o gitish samaradorligini keskin yuksaltiradi.

Qidirish va yullash imkoniyatlari

Yo'llash tizimi barcha axborotlarni tarkiblashtirishga asoslangan bo’lib,
yagona bo lim/bob/mavzu/mavzu osti/ takdim etish ierarxiyasidan foydalansa
bo ladi. Kompyuter ekranida elektron darslikning ushbu ierarxiya tizimi tuligicha
namoyish etilishi mumkin. Bundan tashgari ko'rib chigilgan o'quv materialiga
gaytish, keyingisiga o'tish va giperaloga asosida boshka bo limlardan izlash
imkoniyatlariniham kiritish lo-zimdir.

Elektron darsliklarda qidirish tizimi indeksli va to'lik matnli bolishi
mumekin. Indeksli gidirish biror-bir ko rsatmalar majmuasi asosida yo lga qo’yiladi.
To'lik matnli kidirishda asosan biror-bir so'z, so zlar ketma-ketligi asosida gidirish
mumkin bo'ladi. Kerak bo’lgan axborotlarni gidirishning bunday usullari Internet
xalgaro axborot tarmogida ishlaganlar uchun yangilik emas.

Olingan bilimlar darajasini nazorat gilish

Elektron darsliklar asosida bilim olayotgan talabalarning bilim darajalarini




aniglash uchun ular tarkibidagi avtomatlashtirilgan test tizimlardan foydalaniladi.
Test tizimlari quyidagi talablarga javob berishi lozim:

* test natijalarining ob’ektivligi;

0 quv materiallarini gamrab olish;

« 0 gitish elementlarini test jarayoniga Kiritish;

* gayta test topshirish imkoniyati.

Ko pincha ikki turdagi test topshirish yo'lga goyiladi: javoblarning bir nechta
variantidan bittasini tanlash va ikki gurux elementlarini o'zaro mos kelishini
belgilash.

Javobning berilgan variantlarini tanlash bo'yicha test usuli keng targalgan.
Natijalarning ob’ektivligini ta’minlash va testni qayta topshirishni ta’minlash
magsadida savollar bazadan tasodifiylik asosida tanlab olinadi. Test mobaynida
o gitish elementlarini go'llash bo'yicha talabaga javoblarning to g riligi hagida
axborot berilib boriladi va test tugagandan so'ng yaxshi organilmagan mavzular
ro'yxati beriladi. Test topshirishni biror bir mavzu yoki to’liq kurs bo'yicha
topshirish mumkin.

O gituvchi va o'quvchining o rtasida o'zaro interaktiv va teskari alokaning
yo'lga qo yilishi

Ishlab chigarilayotgan elektron darsliklarni ikki usulda, ya’ni lokal va
tarmoqda foydalanish mumkin. Lokal usuli individual xolda ta’lim berishda, tarmoq
usuli esa o quvchining o gituvchi bilan alogasini o'rnatish uchun qo’llaniladi.
Talabaning o qgituvchi bilan o’zaro alogasi dialog (online) yoki elektron pochta
(offline) ko rinishda amalga oshirilishi mumkin. Asosiy o quv materiali talabaning
kompyuterida joylashgan bo'lib, serverda ayrim ma’lumotlar saglanadi, bu esa
tarmoqda katta xajmdagi axborotlarni uzatishga chek kugadi. Bundan tashqari,
serverda xar bir talaba uchun uning ismi, sharifi, familiyasi, paroli, test natijalari

kabilar saglanadi.




1.2. Masalaning qoyilishi.

Bitiruv malakaviy ishda C dasturlash tili bo'yicha Elektron ma’lumotnoma
yaratish asosiy magsad hisoblanadi. Elektron ma’lumotnoma dasturni yaratishda
birinchi navbatda C dasturlash tili hagida ma’lumotlar yig'iladi va taxlil qgilinadi.
Shundan so'ng Elektron ma’lumotnomaning strukturasi ishlab chigiladi. Struktura
asosida HTML, Flash va FrontPage dasturlari foydalanilgan holda Elektron
ma’lumotnoma yaratiladi.

Elektron o quv resurslarini yaratish jarayonida psixologo-pedagogik, texnik-
texnologik, estetik va ergonomik talablar qo’yiladi. Elektron darslik, Elektron
ma’lumotnoma, Elektron ma’lumotnomalar va uslubiy qo'llanma kabi dasturiy
maxsulotlar go'yilgan didaktik talablarga javob berishi kerak. Didaktik talablar
ta’lim berishning spetsifik (onuniyatlariga va mos ravishda ta’lim berishning
didaktik tamoyillariga mos kelishi kerak.

Dasturni yaratish jarayoni aniq mantigiy davom etadigan harakatlardan iborat
bo'lib, ularni bajarish natijasida ishga yarogli, gonun-qoidalarga asosan
rasmiylashtirilgan dastur maxsuloti yaratiladi. Dastur buyurtmachining texnik
shartlariga javob berganda ishga yaroqgli deb hisoblash mumkin. Uni ugquv jarayonida
qo llash yoki Internet tarmog iga ulangan kompyuterga joylashtirish mumkin.

Masalaning to'gri qo yilishi buyurtmachiga vagt va moliyaviy xarajatlarni
kamaytirishga yordam beradi. Topshirig buyurtmachining maslaxati bilan
go'yiladi. Buyurtmachi o'z imkoniyatlari va o'ylangan loyixaning ganday
bo'lishidan kelib chiqib maslaxat beradi. Ba’zan qo'yilgan topshirikning oxirgi
natijasi boshlangich xolatidan tubdan farq kiladi. Bu tabiiy xoldir, chunki
buyurtmachi bilan mulogot natijasida u 0 ylangan loyixaning shaklini o"zgartiruvchi
qo'shimcha, ba’zan unikal axborotlar berishi mumkin. Masalaning qo yilishi
loyixalash dasturini yaratishini boshlashning birinchi va muxim gadamidir. Masalani
go'yish va muxokama qilishda, loyixaning muvaffagiyatli xizmat ko rsatishida
ganday texnik vosita va resurslardan foydalanishni belgilash lozim.

Tizimlashtirish dasturni yaratish jarayoninning ajralmas gismidir. Strukturani

tartibga solish dastur komponentlarini bo’limlarga tagsimlash natijasida yuz beradi.




Dastur bo"limlari nomlanadi va shunday joylashtiriladiki, foydalanuvchiga axborotni
gabul qilish va elementlarning harakatlanishi yengillashtiriladi. Strukturani
tasdiglashda shunga asosiy e’tiborni garatish kerakki, birinchi darajali hisoblangan

loyixa bo"limlari harakatlanuvchi tugmalarida 0"z aksini topsin.




1.3. C dasturlash tili hagida umumiy tushuncha.

C dasturlash tili universal tildir. U UNIX sistemasi bilan bog langan bo'lib,
bu sistemada ishlatiladigan bir gancha dasturlar C tilida yozilgan. Lekin C
dasturlash tili biron-bir sistema yoki mashina bilan gattiqg bog lanib golmagan. C
dasturlash tilida belgi (liter) lar, shuningdek turli o lchamli butun, suzuvchi
sonlar asos bo'lib xizmat giladi. Bundan tashqari, ko rsatkichlar, massivlar,
operandalardan, tuzilma va birlashmalardan, chigariluvchi ma lumotlarning to'la
ierarxiyasini hosil gilish mumkin. Ifodalar operanda va korsatkichlardan tashkil
topadi. Qiymat uzatish funksiyasini chagirishni qo shib hisoblaganda har bir
ifoda ko'rsatkich bo'lishi mumkin.’

Ko'rsatkichlar bog'ligmas adresli (manzili) mashina arifmetikasini
belgilaydi. C ko rsatma tuzuvchisi ( {} ), (if-else) shart bo'yicha tarmoglanish,
ko'p (switch) dan bir muqobilini tanlash, yuqoriga garab takrorlash (while, for)
va quyiga (do) qgarab takrorlash, shuningdek takrorlashni to xtatish (break) kabi
boshgaruvchi tuzilmalar mavjuddir.

Xar bir funksiyaga rekursiv yondashadi, lekin bir funksiyaning tasviri
iIkkinchi funksiyaning orasida yotishi mumkin emas.

C tilining boshqa tillarga 0 xshash kamchiligi mavjud bo lib, bu tilning

tuzilmalari sintaksisi noqulay.

C Denis Ritchi tomonidan 1972 yili UNIX tipidagi operasion sistemalarini
yaratish uchun loyihalashtirilgan.
Unda operasiyalar, skalyar giymatlar ish olib boradi. Tarkibiy giymatlar esa

ularning elementlariga yaginlashishni tartiblash uchun ishlatiladi.

® https://uz.wikipedia.org/wiki/C_(dasturlash_tili)




I1 Bob. Amaliy gism.
2.1. Elektron ma’lumotnomani yaratishda qo’llanilgan dasturiy vositalar.
HTML TILI.

HTML (Hyper Text Marko p Language) — belgili til bo’lib, ya'ni bu tilda
yozilgan kod o’z ichiga mahsus ramzlarni mujassamlashtiradi. Bunday ramzlar
hujjat ko’rinishini faqatgina boshqarib, o0’z1 esa ko’rinmaydi.

HTMLda bu ramzlarni teg (teg — yorliq, belgi) deb ataladi. HTMLda hamma
teglar ramz-chegaralovchilar (<, >) bilan belgilanadi. Ular orasiga teg
identifikatori (nomi, masalan B) yoki uning atributlari yoziladi. Yagona istisno
bu murakkab chegaralovchilar (<!-- va -->) yordamida belgilanuvchi sharxlovchi
teglardir.

Aksariyat teglar jufti bilan ishlatiladi. Ochuvchi tegning jufti yopuvchi teg.
Ikkala juft teg faqatgina yopuvchi teg oldidan «slesh» (*/””) belgisi qo’yilishini
hisobga olmaganda, deyarli bir xil yoziladi. Juft teglarning asosiy fargi shundaki,
yopuvchi teg parametrlardan foydalanmaydi. Juft teg yana konteyner deb ham
ataladi. Juft teglar orasiga kiruvchi barcha elementlar teg konteyneri tarkibi
deyiladi. Yopuvchi tegda zarur bo’Imagan bir gator teglar mavjud. Ba'zida
yopuvchi teglar tushirib qoldirilsa ham zamonaviy brauzerlar aksariyat hollarda
hujjatni to’g’ri formatlaydi, biroq buni amalda qo’llash tavsiya etilmaydi.

Masalan, rasm qo’yish tegi <IMG>, keyingi qatorga o’tish <BR>, baza
shriftini ko’rsatish <BASEFONT> va boshgalar o’zining </IMG>, </BR> va
hokazo yopuvchi juftlarisiz yozilishi mumkin. Noto’g’ri yozilgan tegni yoki
uning parametri brauzer tomonidan rad kilinadi. (bu brauzer tanimaydigan
teglarga ham taallugli). Masalan, <NOFRAME> teg-konteyneri fagatgina
freymlarni taniydigan brauzer tomonidan hisobga olinadi. Uni tanimaydigan
brauzer <NOFRAME> tegini tushunmaydi.

Teglar parametr va atributlarga (inglizcha. attribute) ega bo’lishi mumkin.
Ruxsat etilgan parametrlar yig’indisi har-bir teg uchun individualdir. Parametrlar
quyidagi qoida asosida yoziladi:

v Teg nomidan so’ng probellar bilan ajratilgan parametrlar kelishi




mumkin;

v’ Parametrlar ixtiyoriy tartibda keladi;

v’ Parametrlar 0’zining nomidan keyin keluvchi «=» belgisi orqali
beriluvchi qiymatlarga ega bo’lishi mumkin.

v Odatda parametrlar qiymati « » - «qo’shtirnoq» ichida beriladi.

v’ Parametr giymatida ba'zan yozuv registri muhim.

HTML 4.0 spetsifikatsiyasida monitor ekranida tagdim etilgan ta'rifdan
hujjat strukturasi ta'rifini ajratish asosiy(xiroueBoii) g’oyaga aylandi. Tajriba
ko’rsatishi bo’yicha hujjatning bu ikkala ta'rifini bir-biridan ajratish platforma,
muhit va shu kabilarni keng migyosda quvvatlashga gilinadigan sarf-harajatlarni
ancha kamaytirar ekan, shu bilan birga hujjatlarga o’zgarishlar kiritishni
osonlashtirar ekan. Bu g’oyaga asosan, uslub (ctun) jadvali yordamida,
xujjatlarni taqdim qilish usulidan ko’plab foydalanish magsadga muvofiq
keladi.

HTML — standarti to’g’risidagi rasmiy ma'lumotlarni W3 C konsortsiumining—

Web-saytidan quyidagi adres bo’yicha olish mumkin:
http://www.W3.org/TR/
4.0 spetsifikatsiyasi quyidagi adresda tayinlangan:
http://www.W3.org/TR/REC.html 4u-971218
HTML ning asosiy teglari

HTML hujjatlari — bu matnli fayllar bo’lib, ularga belgilash teglari deb
nomlangan maxsus kodlar kiritilgan. Bu teglar Web-brauzerlarga matn va
grafiklarni ganday qilib sharhlash va aks ettirish lozimligini ko’rsatib turadi.
HTML fayl — bu oddiy matnli fayl. Shuning uchun uni istagan matn redaktorida,
masalan MS Word yoki oddiy «Bloknot»da yaratish mumkin. HTML sahifa
nima? - bu oddiy text fayl bo'lib, .html gisgartmasiga ega.

Eslatib o’tish joiz, hujjat yaratilgach, uni matn formatida saqlash kerak.
Lekin, bu ishni bajarishdan oldin uning kengaytmasini o’zgartirish, ya'ni TXT

o’rniga HTML yoki HTMni qo’yishni esdan chigarmaslik kerak. HTML va



http://www.wз.org/TR/
http://www.wз.org/TR/REC.html%204u-971218

HTM kengaytmasi HTML fayl uchun standart hisoblanadi. Bundan tashgari, bu
kengaytmalar kompyuterga faylda matnlardan tashgari HTML kodlari ham
mavjudligini ko’rsatib turadi. HTML tili harflar razmeriga befarqdir, ya'ni bosh
va kichik harflar bir xil qabul gilinadi. Lekin teglarni yozishda ko’pincha bosh
harflardan foydalaniladi.

Bundan tashgari, HTML sahifani yaratish uchun maxsus dasturlarni
gidirib topib, sotib olish shart emas. Matn tahrirlovchi har ganday dastur orgali
HTML sahifa yaratish mumkin. Masalan: Windows muxitidagi matn
muxarrirlari: Notepad, TextPad, UltraEdit, EdutPlus. Ana shunday matn
tahrirlovchi oddiy dasturlardan biri bo'lgan Notepad (binokuoTt), Windows
muhitida ishlovchi har bir kompuytreda mavjud. Ba'zi matn muxarrirlarida
HTML hujjatni web brauzerda sinab ko’rish tugmasi mavjud.

HTML xujjatni yaratishga mo’ljallangan maxsus dasturlar (HTML
muxarrirlar) ham mavjud: FrontPage, Adobe GoLive,Macromedia

Dreamweaver, Nestcape Composer. Muharrirlar 2 turga bo’linadi:

« kod muxarrirlari;
o WYSIWYG texnologiyasi (What You See Is What You Get — nimani ko’rsang
o’shani olasan) asosida ishlaydigan muharrirlar. Bu muharrirlar yordamida
foydalanuvchi HTML komandasi va elementlarini yozmaydi, oddiy matn

muxarrirlaridek matn yozadi, tasvirlarni kerakli joyga joylashtiradi, formatini

o’zgartiradi va h.k. xolos.

Web-sahifa ko’rinishi va aks ettirilayotgan axborotning qanaqaligidan qat'iy
nazar, HTML va WWW spetsifikatsiyasiga asosan har bir Web-sahifada ishtirok
etishi zarur bo’lgan quyidagi to’rtta teglar mavjud:

1. <HTML> brauzerga hujjat HTML tilida yozilganligi to’g’risida xabar beradi.
2. <HEAD> HTML-hujjatning kirish va bosh gismini belgilaydi.

3. <BODY> asosiy matn va axborotni belgilaydi.

4. <ADRESS> bu Web-sahifa to’g’risida ko’proq to’la-to’kis axborot olish uchun
kerak bo’ladigan elektron pochta manziliga ega.

Bu teglar Web-brauzerga HTML-hujjatning har xil gismlarini aniglash uchun

juda zarurdir, lekin ular Web-sahifaning tashqi ko’rinishiga to’g’ridan-to’g’ri




ta'sir etmaydi. Ular HTMLga kiritilgan navbatdagi yangi ma'lumotlar uy
sahifalarida to’g’ri sharhlash, shu bilan birga barcha Web-brauzerlarda bir xil
ko’rinishga ega bo’lishi uchun juda zarurdir.

Demak, HTML tili andozasi boyicha hujjatga <HEAD> va <BODY> teglarini
Kiritish tavsiya etiladi. Brauzer HTML hujjatni o giganida, ularning borligi hujjat
bo’limlarini aniq ko rsatadi. Agar ular bo’Imasa ham brauzer HTML hujjatni

to g ri o qiydi, lekin hujjat bo"limlari bir-biridan ajralib turmaydi.

Shunday qilib, to g ri tuzilgan HTML hujjat quyidagi tuzilishga ega:

<HEAD>

Sarlavhaga oid ma'lumot

</HEAD>

<BODY>

Hujjatning mazmuni

</BODY>

Bunda <HEAD>, </HEAD> orasida joylashgan sarlavhaga oid ma‘'lumot gismida
odatda foydalanuvchiga e'tiborsiz, lekin brauzer uchun lozim ma‘lumot beriladi.
<BODY>, </BODY> orasiga esa tolaligicha uning operatorlari ketma-ketligi
joylashtiriladi.

Masalan, sizning Web-serveringizda barcha HTML - hujjatlarni ko’radigan
va ularning ro’yxatini tuzadigan dastur ishga tushirilgan. U <HEAD> teglari
ichida joylashgan matnlarni ko’radi, xolos (bu erda hujjatlar nomi ham
joylashtirilgan bo’ladi). Shunday qilib, agar uy sahifalarida <HEAD> va
</HEAD> teglari bo’Ilmasa, u holda u ro’yxatga kiritilmaydi. Anchagina nomi
chiggan Web-serverlar — gidiruv vositalarining ko’pchiligi mana shunday
ishlaydi. Ular axborotlarni <HEAD> teglaridan oladi.

Yugoridagi fikrlarga asoslangan holda Web-sahifada ishtirok etishi zarur bo’lgan

quyidagi to’rtta asosiy teglarni tavsiflashga harakat qilamiz.
« <HTML> va </HTML> teglari

Bu teglar brauzerlarga ular orasidagi matnni xuddi HTML matni kabi
sharhlash (izohlash) zarurligi to’g’risida xabar beradi, chunki HTML-hujjatlari
fagat matnlidir. <HTML> teg esa, faylning gipermatn bog’lanish tilida




yozilganligini bildirib turadi.
« <HEAD> va </HEAD> teglari

Bu teglar Web-sahifalar nomlarini belgilaydi. Buning uchun <HEAD> va
</HEAD> teglar orasida Web-sahifa nomi kiritiladi. Ya'ni HEAD bo’limi
sarlavha hisoblanadi va u majburiy teg emas, birog mukammal tuzilgan sarlavha
juda ham foydali bo’lishi mumkin. Sarlavha qismining magsadi hujjatni tarjima
gilayotgan dastur uchun mos axborotni etkazib berishdan iborat. Hujjat nomini
ko’rsatuvchi <TITLE> tegidan tashqari bu bo’limning qolgan barcha teglari
ekranda aks ettirilmaydi. Odatda <HEAD> tegi darhol <HTML> tegidan keyin
keladi. <TITLE> tegi sarlavhaning tegidir, va hujjatga nom berish uchun hizmat
kiladi. Hujjat nomi <TITLE> va </TITLE> teglar orasidagi matn gatoridan iborat.
Bu nom barauzer oynasining sarlavhasida paydo bo’ladi (bunda sarlavha nomi 60
belgidan ko’p bo’lmasligi lozim). O’zgartirilmagan holda bu matn hujjatga
«zakladka» (bookmark) berilganda ishlatiladi. Hujjat nomi uning tarkibini
qisqacha ta'riflashi lozim. Bunda umumiy ma'noga ega bo’lgan nomlar

(masalan, Homepage, Index va boshqgalar) ni ishlatmaslik lozim. Hujjat
ochilayotganda birinchi bo’lib uning nomi aks ettirilishi, so’ngra esa hujjat asosiy
tarkibi ko’p vaqt olib, kengayib ketishi mumkin bo’lgan formatlash bilan birga
yuklanishini hisobga olgan holda, foydalanuvchi xech bo " Imaganda ushbu
axborot gatorini o’qiy olishi uchun hujjatning nomi berilishi lozim.

*. Har bir HTML hujjat faqatgina bitta nomga (sarlavhaga) ega bo’ladi.
So’ngra uning oldi va orqa tomonlarini <TITLE> va </TITLE> teglari bilan
belgilang.

U, odatda brauzer darchasi sarlavhasida ko’rsatiladi. Konteyner <TITLE> tegini
hujjat faylining nomi bilan adashtirmaslik kerak. Aksincha u fayl nomi va
manziliga butunlay bog’liq bo’lmagan matn satridir. Fayl nomi kompyuterning
operatsion tizimi (OT) orgali gat'iy ravishda aniglanadi. Shu bilan birga, hujjatlar
nomi (teg <TITLE> bilan birga) ni hujjat ichidagi ko’pincha <H> teglari bilan
joylashadigan sarlavhalardan farglash kerak bo’ladi.

. <BODY>va </BODY> teglari




<BODY> va </BODY> teglari <HEAD> kabi HTML hujjatning maxsus
gismlarini belgilashda ishlatiladi. <BODY> teglari egallab olgan matn hujjatning
asosiy gismi hisoblanadi. Matnning katta gismi va boshga axborotlar ham uning
tarkibiga kiritiladi. Quyida <BODY> tegining bir gator parametrlarini keltiramiz.
<BODY> tegi parametrlari:

ALINK - faol murojaat (ccpuika) ning rangini belgilaydi.

BACKGROUND - fondagi tasvir sifatida foydalaniluvchi tasvirni belgilaydi.
URL - manzilini belgilaydi.

BOTTOMMARGIN - hujjatning quyi chegaralarini piksellarda belgilaydi.
BGCOLOR - hujjat fonining ranglarini belgilaydi.

BGPROPERTIES —agar FIXED qgiymati o’rnatilmagan bo’lsa, fon tasviri
aylantirilmaydi.

LEFTMARGIN — chap chegaralarni piksellarda belgilaydi.

LINK — xali ko’rib chigilmagan ssilkaning ranggini belgilaydi.

RIGHTMARGIN — hujjat 0’ng chegarasini piksellarda o’rnatadi.

SCROOL - brauzer darchalari harakatlantirish (prokrutka) yo’laklarini o’rnatadi.
TEXT — matn rangini aniglaydi.

TOPMARGIN — yuqori chegarasini piksellarda o’rnatadi.

VLINK — ishlatilgan murojaat rangini belgilaydi.

BOTTOMMARGIN, LEFTMARGIN, RIGHTMARGIN va TOPMARGIN
pametrlari matn chegarasi va darcha chetlari orasidagi masofani piksellarda

belgilaydi.
« <ADDRESS> va </ADDRESS> teglari

Bu teglar mazkur sahifaga nisbatan kimdadir savol yoki fikr tug’ilib qolgan
taqdirda kimga murojaat qilish kerakligi to’g’risidagi axborotlarni 0’z ichiga
oladi.

<ADDRESS> teglari bu axborotlarni asosiy blokdan ajratib olish uchun
ishlatiladi. Uy sahifasiga bu teglarni kiritish uchun quyidagi gadamlarni
bajaramiz:

1. <BODY> va </BODY> teglari orasida ismingizni va elektron pochta adresini
tering.




2. So’ngra ismingiz va adresingizga <ADDRESS> tegini kiriting.
3. Ism (nom) va adresdan so’ng, yopuvchi </ADRESS> tegni kiriting.

Endi Web-sahifani (misol tariqasida) ko’rib chiqamiz:
<HTML>
<HEAD>
<TITLE> Web-sahifa misoli </TITLE>
</HEAD>
<BODY>
<H1> bizning Web-sahifamiz </H1>
<P> bu Web-sahifa Web-dizayner bo’lishi mumkinligini namoyish qilish
magsadida yaratilgandir. Buning uchun Web-serverga sozlanishi giyin dastur
talab gilinmaydi. Bunda sizning operatsion tizimingiz muvaffagiyat bilan uning
o’rnini bosa oladi. </P>
</BODY>
</HTML>
Bu erda terminologiya to’g’risida biroz oldindan kelishib olishimiz kerak.
HTML—hujjatda xato bo’lsa, lekin baribir brauzer tomonidan chidab bo’larli
darajada ko’rsatilsa, bunday hujjatni yaxshi rasmiylashtirilgan hujjat deyiladi.
Aksincha, rasmiylashtirishda xatosi bo’lmagan HTML hujjat standart
hujjat deyiladi.
Sahifamiz kodiga yana bir bor nigoh tashlaymiz. Barcha HTML hujjat juft teglar
— <HTML> va </[HTML> ichida joylashganligi ma'lum bo’ladi. Bu standart
HTML-hujjatlarni rasmiylashtirishning birinchi qoidasidir. Ikkinchi
qoidabo’yicha HTML-hujjat ikkita bir-biriga teng bo’lmagan sektsiyaga
bo’lingan bo’ladi.
Birinchi (kichik) sektsiya — bu HTML sarlavha. HTML sarlavha juft teglar —
<HELD> va </HEAD> bilan ajralib turadi. U brauzer darchasida aks etmaydi,
lekin brauzer o’z ehtiyojlari uchun foydalanadigan xizmat axborotlarini 0’z ichiga
oladi.
Ikkinchi (katta) sektsiya — bu hujjat jismi deb ataladigan shaxsiy hujjat. Xuddi
mana shu hujjat jismi brauzer darchasida aks ettiriladi. Jism juft teglar —
<BODY> va </BODY> hilan ajralib turadi. Bu erdan standart HTML hujjatlarni




rasmiylashtirishning ikkinchi qoidasi kelib chigadi: har bir hujjatda HTML
sarlavha va test gipermurojaatlari (cceuika) bo’lishi va bu ikkala sektsiyalar
to’g’ri rasmiylashtirilgan bo’lishli shart.

<BODY> tegida matn va fon rangi to’g’risidagi axborot mavjud bo’lishi mumkin.
Buning uchun chap teg formatini ozgina o’zgartirish kerak bo’ladi.

Masalan: <BODY BGCOLOR=“FFFFOO” TEXT="000000”>.

Bu erda BGCOLOR parametri fon rangini, TEXT esa matn rangini aniglab

beradi. Bu misolda fon uchun sarig, matn uchungora ranglar tanlangan.

Misollar:

1. <BODY TEXT = “#000000”> yoki <BODY TEXT = black>

2. <BODY BGCOLOR = “#ffffff”> yoki <BODY BGCOLOR = WHITE>

3. <BODY LINK = “#ff0000> yoki <BODY LINK = RED>

4, <BODY LINK = “#00oFFFF” ALINK = “#800080> yoki <BODY VLINK =
Aqua ALINK = PURPLE>

Misol:

<HTML>

<HEAD>

<TITLE> - sahifa fonini berish misoli </TITLE>

</HEAD>

<BODY BGCOLOR=YELLOW TEXT=BLACK LINK=RED VLINK=PURPLE
ALINK=GREEN>

</BODY>

</HTML>*

Front Page da Web sayt yaratish.
Buning uchun:
e Ob’ekt bilan tanishib chigiladi va masalaning qo'yilishini va
foydalaninshini to"la xal gilib olinadi.

e Qo yilgan masala uchun mos uslub tanlanadi.

* http://www.tami.uz/view_post.php?id=13




e Saytga mos material (matn, rasm , ovoz, tasvir va boshkalar) olinadi va
shular asosida Front Page muxarririga murojaat kiladi. Web sayt
yaratish quyidagicha amalga oshiriladi:

Pusk — Programmsr - Front Page buyrug'i bajariladi. File - New/Sozdat —
«Yangi yaratish» buyrug'i orgali Web (Web sayt) bo'limi tanlanadi va NEW/Sozdat
mulogot oynasi ochiladi.

Undan quyidagi ko rsatilgan yo nalishlardan biri tanlanadi:

Customer Support Web (iste’molchilar taklifi bo’yicha Web sayt),
Projeet Web (Loyixa bo yicha Web-sayt)

Personal Web(Shaxsiy Web-sayt)

One Page Web (Bitta saxifali Web sayt)

Emply Web(bush Web sayt) va boshk.

Speety The Loeation of the New Web(Saytga yo'| ko rsatish)satriga
yo“nalish ko rsatiladi.’

MACROMEDIA FLASH DASTURI VA UNING IMKONIATLARI.

Flash interfeysi Adobe firmasining dasturlari (masalan, PhotoShop)
interfeysiga 0 xshash bo’lib, nugtali grafika bilan ishlashga mo'ljallangan.

Chapda chizish uchun mo’ljallangan instrumentlar paneli joylashgan. Ular
yordamida instrumentlar tanlanishi, shuningdek ishchi sohani boshqarish, ob’ektlarni
0 zgartirish va ranglar tanlash mumkin. O 'ng tomonda instrumentlarda sozlash, rang,
matn, kadrlar xususiyati va ob’ektlar palitralari joylashgan. O rtada ishchi soha, uning
ustiki gismida esa vaqgt diagrammasi (Timeline). Ishchi sohada alohida grafik va
matnli elementlar yaratiladi.

Ishchi soha ostida xususiyatlar palitrasi (Properties) joylashgan bo’lib, u turli
ob’ektlar xususiyatlarini o zgartirish uchun moljallangan.

Flash da bajarilgan ishlarining natijasini (fayllar, animatsiya, sahifalar) — multi-
film, klip, videofragment, rolik va animatsiyalar deb atash gabul gilingan (umumiy
termin mavjud - movie).

Flash da rolik yaratish jarayoni quyidagicha:

Dastlab FLA kengaytmali boshlang’ich yoki mualliflik fayl (tahrirlab

® Sariev R.B. “Kompyuter grafikasi va dizayn” fanidan ma’ruzalar matni, tajriba va amaliy mashg ulotlar

bo’yicha uslubiy ko'rsatmalar. Bux. 2010 y.




bo'ladigan boshlang’ich fayl) yaratiladi. Keyin brauzerda ko'rish mumkin bo’lgan
SWEF-faylga o zgartiriladi. Bundan tashgari, ishning natijalarini keng targalgan
formatlar fayllari AVI , animatsion GIF, JPEG va boshga formatlarga eksport gilish
mumkin. °

Timelines palitrasi.

Vaqt shkalasi Flashda animatsiya bilan ishlashning asosiy instrumenti
hisoblanadi. Unda gatlamlar hagida va qgaysi kadr kalit kadr, gaysilari oraliq kadr
ekanligi hagidagi axborotlar tasvirlangan. VVaqt shkalasi yordamida gaysi kadr harakat
yoki belgi saglashini aniglash mumkin. U kalit kadrlarni va animatsiyaning alohida
gismlarini harakatlantirish imkoniyatini beradi. Bu instrument juda qulay bo'lib unda
ishlashni tezda o zlashtirib olish mumkin. Vaqgt shkalasining asosiy elementlarini
sanab otamiz:

Marker - qizil rang bilan ajratilgan to'g'ri burchak bo'lib, ishchi sohada
tasvirlangan joriy kadrni bildiradi.

To'g'ri burchakli to'r yacheykalari (kadrlar shkalasi) - kadrlarni bildiradi.
Yacheykalarning birortasi bosilsa, marker avtomatik tarzda o'sha yacheykaga
ko chadi va ishchi sohada o'sha kadr tasvirlanadi.

Qatlamlar - kadrlar lineykasidan chapda gatlamlar joylashgan. Ular ostida
gatlamni qo’shish yoki olib tashlash imkonini beruvchi tugmalar joylashgan. Har bir
gatlamni ko'rinmas qilish yoki tahrirlashni ta’qiglash ham mumkin.

Kadrlar shkalasi - oddiy va kalit kadrlarni go shish yoki olib tashlash mumkin
bolgan maydon. Agar birorta kadrda sichqonchaning o'ng tugmasi bosilsa,
yordamchi (kontekst) menyu chigadi. Unda amalga oshirilishi mumkin bo’lgan
harakatlar ro'yxati paydo bo'ladi. Kadrlar shkalasida quyidagi axborotlar
tasvirlangan:

-Kalit kadrlar qora aylanachalar bilan belgilangan;

-Harakatlar bilan bog lig kadrlarda aylanachalar ustida «a» harfi qo yilgan;

-Belgilangan kadrlarda gizil bayroqgcha va belgi nomi qo yilgan.

Kadr rangi uning gaysi tipga mansubligini bildiradi: takrorlovchi kadr kulranga
bo yalgan, binafsha yoki yashil rangli kadrlar Flashda gayta ishlangan kadrlar, oq

® Vladimir Dronov, “Macromedia Flash MX”, Sankt-Peterburg - 2008.




rangda bo sh kadrlar ko rsatiladi.
Asboblar palitrasi tavsifi. Simvollar: roliklar, tugmalar, tasvir.

Arrow Tool - ko'rsatkich asbob. Sahna ob’ektlarini tanlash uchun
mo"ljallangan.

Subseletion Tool - egri chiziglarni tahrirlash uchun mo’ljallangan bo’lib, egri
chiziglarga yangi tugun nugtalar qo'shish va mavjud tugun nugtalarni tahrirlash
imkoniyatini beradi.

Line Tool - to g ri chiziglarni chizishga mo’ljallangan.

Lasso Tool - murakkab ob’ektlarni belgilash uchun mo’ljallangan. Ikkita
ishlash muhitiga ega - sehrli tayoqcha (rangi o xshash sohalarni belgilash) va
poligonal belgilash. Bularning ishlash tartibini asboblar palitrasining Options
bo limidan tanlash mumkin.

Pen Tool - egri chiziglarni chizishga mo'ljallangan.

Text Tool - matn yozuvlarini yaratish uchun mo"ljallangan.

Oval Tool- aylana va ellipslarni chizishga mo'ljallangan.

Rectangle Tool - to'g'ri burchaklarni chizish uchun mo ljallangan. Asboblar
palitrasining Options bo'limida to'g'ri burchakning burchaklari o’lchamini tanlash
mumekin.

Pencil Tool - ixtiyoriy turdagi egri chiziglarni chizishga mo’ljallangan.
Asboblar palitrasining Options bo’limida egri chiziglarning silliglik darajasini tanlash
mumekin.

Brush Tool- egri chiziglarni maxsus shaklli mo’ygalam bilan chizishga
mo ljallangan. Asboblar palitrasining Options bo limida mo ygalamning shakli va
0 lchamini tanlash mumkin.

Free Transform Tool - ob’ektlarni transformatsiya gilishga mo ljallangan
(geometrik o’ Ichamlarni o"zgartirish, aylantirish, siljitish).

Fill Transform Tool- gradientni transformatsiyalash.

Ink Bottle Tool- ob’ektlarning chegaraviy chiziglar parametlarini o zgartirishga
mo"ljallangan.

Paint Bucket Tool- ob’ektlarni bo yashga mo'ljallangan. Ko pincha bu asbob
Color Mixer palitrasi bilan ishlatiladi.

Eyedropper Tool- instrument pipetka. Bo'yash yoki shakl rangidan namuna




olib, boshga ob’ektga ishlatish uchun moljallangan.

Eraser Tool- ob’ekt gismlarini o chirishga mo ljallangan.

Hand Tool va Zoom Tool — ishchi sohaning joylashishini va masshtabini
0 zgartirishga mo'ljallangan.

Simvollar: roliklar, tugmalar, tasvir.

Simvol - Flashdagi asosiy tushunchalardan biridir. Simvol oddiy figura, bir
necha figuralar birlashmasi va hatto animatsiya (movie) ham bo lishi mumkin.
Masalan, «g ildirak», «kuzov», «chirog» simvollarini yaratish mumkin, keyin esa
buning hammasini («avtomobil» simvoliga) birlashtiriladi.

So'ng esa bu «avtomobil»ning «yurish» sahnasi yaratiladi. G ildirakni (uning
aylanayotganini bildirish uchun) animatsiyalangan simvol gilib kiritiladi va xohlagan
paytda simvol tipi va tarkibini o zgartiriladi. Boshgacha qilib aytganda, simvol bu
ob’ekt. Ob’ekt termini odatiy bo’lsa ham, lekin Flash da aynan simvol termini
ostida ishlatiladi.

Simvollarning uch xil ko rinishi mavjud: rolik (MovieClip), tugma (Button) va
tasvir (Graphic).

Tasvir (Graphic) fagatgina bitta kadrdan iborat simvoldir. Uning statik nomi
ham shundan kelib chiggan. Agar simvol hagigatdan ham statik ob’ekt (animatsiya
mavjud bo’Imasa) bo’lsa, uni tasvir (Graphic)ga aylantirish magsadga muvofig.

Tugma (Button). Bu simvol Flash da maxsus funktsiyalarni o'z ichiga olgan
simvol hisoblanadi. Unda to'rtta kadr mavjud: Up, Over, Down, Hit. Tugmalar
quyidagi holatlarini saglaydi:

-Up- tugmaning odatiy holati;

- Over- Sichgoncha kursori tugma ustida bo lIgan holati;

- Down- kursor tugma ustida va sichgoncha tugmasi bosilgan holati;

- Hit- sichgoncha ko'rsatkichidan ta’sirlanadigan sohani aniglaydi (figurali
tugmalar uchun foydalidir).

Animatsiya (MovieClip) - bu simvolning eng «mukammal» tipi. Bu tipdagi
simvol Action Script (Flash da o rnatilgan dasturlash tili)dagi Movie tipiidagi ob’ekt
sifatida gabul gilinadi.

ACTIONSCRIPT hagida umumiy tushuncha




Flash tarkibiga kiruvchi ActionScript stsenariylar tili - murakkab interaktiv
filmlarni yaratish imkonini beradi. Shunga garamay, Flashning oldingi versiyalarida
mukammal stsenariylar muxarriri yo gligi tufayli stsenariylarni ishlab chigish biroz
cheklangan edi. Endi bunday muxarrir yaratildi. Bundan tashqgari, tilning o°zining
imkoniyatlari xam kengaytirildi.

e Muxarrirning yangi versiyasiga quyidagi asosiy qo shimchalar Kiritildi:
sintaktik konstruktsiyalarni avtomatik kiritish;

e Sintaksis stsenariylarning ActionScript tili bo'yicha kontekstga bog lik
ma’lumotlar;

e Harakatlanish panelining mukammallashgani;

e Kodni avtomatik formatlash;

e Kod gismlarini kidirish va urnini almashtirish funktsiyalari;

e Munxarrir ishi parametrlarini sozlash funktsiyasi.

Shuningdek, muxarrirdan ikki muxitda foydalanish imkoniyati saglangan:
oddiy (Normal) - boshlovchi foydalanuvchilar uchun, va kengaytirilgan (Expert) -
ActionScript bilan yaxshi tanish bo'lgan foydalanuvchilar uchun.

Tilning sintaksisiga quyidagi asosiy o zgartirishlar Kiritilgan:

. film kurilayotgan vaqgtda uning parametrlarini dinamik boshqgarish funktsiyasi
go shilgan (xususan, oyna joylashishi va o' Ichamlarini 0" zgartirish);

. tilning ob’ekt modeli kayta ishlangan (sichqoncha ko rsatgichini joylashtirish,
klaviaturadagi tugmani bosish va boshgalar); bundan tashqari, endi
foydalanuvchi o°zining ob’ekt va xodisa tiplarini yaratishi va ularni 0°zining
filmlariga Kiritishi mumkin;

. filmning vaqt parametrlarini boshgaruvchi maxsus buyruglar qo shilgan
(Setinterval va ClearInterval), ular ba’zi xollarda vaqt diagrammasi yordamida
boshgargandan ko'ra samaraliroqdir;

« «Matny (Text) va «tugmax» (Button) ob’ektlari parametrlarini boshqarish
bo yicha imkoniyatlar kengaytirilgan; xususan, film kurilayotgan vaqgtda
statik matnni murojaatga aylantirish mumkin va aksincha;

« til tarkibiga yangi operator- Switch kiritilgan, If bilan tagqoslaganda u
mantiqiy shartlarning ketma-ketligi yozilishini qulayroq va chiroyliroq

bolishini ta’minlaydi.




Bundan tashqari, tilning asosiy funktsiyalarini amalaga oshirish yaxshilandi
(Number, Boolean, Object, String, Array va XML kabilar), shuning uchun ular
avvalgiga karaganda 100 marta tezrok bajariladi.

Flash MX versiyasiga Kkiritilgan oxirgi mukammallashtirishlar natijasida
ActionScript xaqiqiy dasturlashtirish tiliga aylandi. Unga Kkiritilgan imkoniyatlar
sizning oldingizda turgan kitob xajmiga teng aloxida kitobda bayon etilishiga loyik.
Tabiiyki, imkoniyatlarning o’sishi bilan tilning murakkabligi xam oshdi. Va uni
boshlovchi dasturchi o zlashtirishi mumkin, lekin baribir dasturchi. Chunki, xatto eng
tajribali kompyuter foydalanuvchisi xam o°zini dasturchi deya olmaydi. Shuning
uchun biz ActionScript da stsenariylar ko rishning umumiy goidalari va tilning asosiy
kontseptsiyalarini ifodalash bilan chegaralanamiz. Tajriba shuni ko rsatadiki, bunday
darajadagi bilimlar uncha murakkab bo’lmagan, lekin anik ishlaydigan interaktiv
filmlarni yaratish uchun yetarlidir.

ActionScript Klip, tugma yoki kadr uchun stsenariy yaratish imkonini beradi.
Bunday stsenariylarning xar biri (ya’ni, ActionScript tilidagi dastur) filmning mos
elementi bilan qattik bog'langan. Filmni nashr gilganda stsenariy matni filmning
boshga elementlari kabi SWF-faylga eksport gilinadiStsenariydan filmning istalgan
boshka ob’ektiga (tugmalar, kliplar va kadrlarga) va xatto boshga filmga yoki
gandaydir tashki tarmoq resursiga murojaat gilishingiz mumkin. Masalan, hisoblovchi

boshcha uninchi ragamli kadrga yetganda www.sound.ru saytida joylashgan tovushli

faylni yuklash kerakligini ko rsatish mumkin. Shuning uchun Flash stsenariyda
gatnashayotgan ob’cktlar ganday «munosabatlarda» ekanligini bilishi kerak. Ob’ektga
noto g ri murojaat qilish albatta stsenariyda xatolik bo’lishiga olib keladi. Aytaylik,
aniq bir Klipning o ninchi kadriga ovoz berish o'rniga, so ralgan tovushli fayl film
vaqt diagrammasining o ninchi kadrida ishga tushadi.

Yugoridagi xolatlarni hisobga olib, ActionScriptda ishlashni boshlashdan oldin
iIkki tushunchani farglash foydali: tilning ob’ekt modeli va stsenariyni bajarish

konteksti. ’

1. " Dmitriy Gurskiy, “Action Script 2.0 Programmirovanie vo Flash MX 2004, M.. 2005.
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2.2. Elektron ma’lumotnoma yaratish bosqgichlari.

Elektron ma’lumotnomani yaratishni ikki bosgichda amalga oshiramiz. Birinchi
bosqgichda C dasturlash tili bo’yicha barcha ma’lumotlarni, jumladan amaliy va tajriba
mashg ulotlari uchun uslubiy ko rsatmalar, nazorat savollari, test savollari, sxematik
atamalar va boshga ma’lumotlar yig iladi va tahrirlanadi. Bundan tashqari birinchi

bosgichda Elektron ma’lumotnoma tuzilmasi ishlab chigiladi:

Elektron ma’lumotnoma

A 4 A 4 Y A\ 4

Asosiy gism Virtual Test Yordam
ko'rgazmalar

\ 4 Y
Ma’ruzalar Qo’shimcha

Ikkinchi bosgichda HTML tili hamda FrontPage dasturi yordamida struktura va
mavjud ma’lumotlardan foydalanib, Elektron ma’lumotnomani yaratishga Kirishamiz.
Tuzilmadagi barcha gismlar HTML tili hamda FrontPage sahifasi ko rinishida
rasmiylashtiriladi. Elektron ma’lumotnomani yaratishda Flash texnologiyasi asosida
harakatlanuvchi animatsiyalar hamda test nazorati uchun maxsus dastur ishlab
chigamiz va tuzilmaga mos ravishda o'rnatib chigamiz. Sahifalarni yaratishda va
ularda Elektron ma’lumotnoma ma’lumotlarini joylashtirishda FrontPage dasturining
barcha imkoniyatlaridan fodalandik va bu imkoniyatlarni gisgacha tavsiflab o tamiz.

Yangi sahifalarni yaratish

File menyusining New menyusi bilan muxarirrda yangi saxifa yaratiladi. New
mulogot oynasida Normal Page tanlanadi va OK tugmasi bosiladi. Ekranda bo'sh
saxifa paydo bo'ladi. Unda Word dagi kabi matn teriladi. Matnlar shriftlari
o lchamlarini o zgartirish, shriftlarini almashtirish matn rangini o zgartirish, maxsus
simvollar royxatlar bilan ishlash, ro'yxatlarni yaratish, yaxlit matnni royxatga
aylantirish, butun ro'yxat stilini o zgartirish, gorizontal chiziglar Kkiritish, ularni
formatlash, dekoratsiyalardan foydalanish va boshka shunga o'xshash ko p ishlarni

bajarish mumkin.




Saxifaga dekoratsiya (bezak) berish quyidagi tarzda amalga oshiriladi: Masalan,
yo Iboshchi (provodnik) da bo'la turib, kerakli dekoratsiya tanlanadi. Endi uni
gandaydir bir saxifaga, dekoratsiyaning boshga elementlarini buzmasdan qo’yish
kerak. Buning Choose Theme (dekoratsiyani tanlash) oynasi uchun Format
menyusining Theme (dekoratsiya) bo"limi tanlanadi.

Bu oyna yo'lboshchidan xuddi shunday ismli oyna bir xil ishlaydi. Oyna bu
sayt uchun ishlatilayotgan dekoratsiyalarining ichidan to'gri keladiganini tanlash
yeki yangisini yaratish uchun imkoniyat beradi.

Auto Thumbnails buyrug idan foydalanib, Front Page gandaydir bir tasvirni
Kichraytiradi va uni saxifaga o rnatadi. Bu nusxadan asliga murojaat xam qoyiladi.

Oldindan ko'rinishda miniatyuralar yaratish uchun tanlangan rasm ajratiladi.
Tools (asboblar) menyusidan Auto Thumbnails bo’limi tanlanadi yeki Ctrl+T
tugmalar bosiladi. Front Page bu tasvirning kichraytirgan nusxasini avtomatik tarzda
yaratadi va uni saxifaga o rnatadi, undan asl nusxaga giper murojaat o yiladi. Kichik
tasvir uchun aniq sozlashlarni Optious mulogot oynasidan berish mumekin.

Murojaat (eki gipermurojaat) - bu ikki nugtani birlashtirishdir. Murojaatda
tanlangan nugtadan murojaat nuqtasiga sakrab o'tiladi. Murojaat joyi URL (Uniform
Resource Locator) resursning unifitsirlashgan lokatori ko rinishda ifodalanadi.
Murojaatlar matn, tasvir va boshka fayllarni, shuningdek xujjatlar ichidagi ilovalarni
ko rsatish mumkin. Front Pagedan foydalanib turib, HTML saxifalarini va Office
fayllarini oddiygina ulash mumkin.

Murojaatlarni yaratish

Murojaatni o rnatish u boshlanadigan matn gismi yoki tasvirni ajratib olish va
<CtrI>+<k> tugmalarni bosish yoki Edit bo'limidan Hiperlink (Gipermurojaat)
buyrug'ini tanlash kerak Create Hiperlink (Gipermurojaat yaratish) mulogot oynasi
chigadi, kerakli soxa tanlanadi va asboblar panelidagi  Sreate or Edit Hiperlink
tugmasi bosiladi.

Kompyuterda mavjud faylga gipermurojaat o rnatish uchun Make a Hiperlink
to a file on your Computer (kompyuterdagi faylga murojaat yaratish) tugmasi bosiladi
va paydo bo lgan Select File (Fayl tanlash) mulogot oynasida kerakli fayl ko rsatiladi.

Yangi saxifaga murojaat yaratish uchun Create a page and link to the New Page

tugmasi bosilib, New (yangi saxifa) mulogot oynasi chagiriladi.




Tasvirlarni joylashtirish.

Tasvirni joylashtirish uchun muxarrirning Insert menyusidan Image (tasvir)
buyrug'i tanlanadi, shundan keyin quyida keltirilgan protsedura bajariladi:

Muxarrir oynasida tasvir qo'yilishi kerak bo’lgan joyga kursor o rnatiladi.

Insert menyusida Image tanlanadi. Bu yerda ochilgan saytdan ixtiyoriy fayl
tashlanadi. Fayl tarkibi mulogot oynasining o'ng soxasida chigadi. Agar
kompyuterdagi fayl tanlanadigan bo’lsa, qo'shni Select a file on your Computer
tugma bosiladi, bu xolda Select File mulogot oynasi paydo bo'ladi. Bu mulogot
oynada kompyuterdagi ixtiyoriy faylni tanlash mumkin. Cancel tugmasi bosilib,
Image mulokat oynasiga o tiladi.

Shuningdek Front Page tasvirlarning jamlanmasiga (ClipArt) xam ega, bundan
tashqari u Microsoft Office tasvirlar kutubxonasidan xam foydalana oladi. Tasvirlar
jamlanmasiga chigish uchun Image mulogot oynasidagi ClipArt tugmani bosish yoki
Insert menyusidan ClipArt buyrug ini tanlash kerak. Ekranda Microsoft Clip Gallery
mulogot oynasi paydo bo'ladi.

U to rtta saxifaga ega ClipArt (illyustratsiya), Pictures (tasvir), Sounds (tovush)
yoki Video (video), kerakli tasvir tanlangach Insert(qo yish) tugmasi bosiladi. Agar
tovushlar va videoroliklar tanlangan bo’lsa, ularni go yishdan oldin Play tugmasini
bosish kerak. Agar tanlangan tasvirlar yogmasa, Connect to Web for additional clips
(go shimcha illyustratsiyalar uchun Internetga murojaat) tugmasi bosiladi bu xolda bir

zumda www.microsoft.com satriga tushiladi. Bu yerda tanlangan ixtiyoriy tasvir

foydalanuvchi kutubxonasiga qoyiladi.
Tovushlar.

Front Page bir necha xil tovush fayllariga (WAV, MID, AIF, AIFC,AIFF, AU,
SND kengaytmali) ega.

Fon tovushlarini qo'yish va uning xossalarini o'rganish Page Properties
(saxifalar xossasi) mulogot oynasida amalga oshiriladi. Saxifaga tovushni kiritish
uchun quyidagi ishlarini bajarish lozim.

1. Sichgoncha ung tugmasi bosiladi kontekst menyudan Page Properties (yoki
File menyusidan Page Properties) buyrug'i tanlanadi.

2. General (umumiy) ichki saxifaning Background Sound (fon tovushi)

bo limida kerakli faylga borish yo’li ko rsatadi.



http://www.microsoft.com/

Tovushni joriy saytdan, brauzer yordamida Internetdan tanlash yoki lokal
diskdan ko'rsatish mumkin. Shundan keyin OK tugmasini bosilib Page Properties
mulogot oynasiga kaytiladi.

Page Properties mulogot oynasining Loop satrida tovushning takrorlanish soni
ko rsatiladi. Agar tovush davriy takrorlanishi kerak bo’lsa Forever (doimiy) ga belgi
go yiladi.

OK tugmasi bosilib, Page Properties mulogot oynasidan chigiladi.

Siljuvchi tugmalar

Sichgon xarakteri ta’siriga javob beruvchi, xususiy gipermurojaatlariga ega
bo lgan siljuvchi tugma yaratish uchun quyidagi ishlarni gilish kerak.

Insert menyusidan Active Elements, keyin paydo bo'lgan menyudan Hover
Button buyrug’i tanlanadi. Hover Button oynasida bir kator standart, shuningdek, bir
gancha go shimcha imkoniyatlar yaratib beruvchi optsiyalar bor.

Standart optsiyalariga quyidagilar kiradi:

- Button Text (tugmadagi matn). Tugmaga yozilishi kerak bo’lgan matn Button
Text matn maydonida kiritiladi.

- Link to (murojaat). Agar tugma gipermurojaat bilan bog'lik bo’lsa, uni shu
matn maydoniga URL ga Kkiritish yoki Browse tugmasini bosish URL ni berish
kerak.

- Button Color (tugma rangi). Bu ochiladigan ro’yxat tugma rangini berish uchun
kerak.

- Effect, Effect color. Effect ro'yxatda vizual effektlar to’plamidan bittasini
tanlash mumkin. Tugma rangi Effect color ro yxatidan tanlanadi.

- Width (eni), Height (balandligi). Bu yerda tugma eni va balandligini
ko rsatuvchi giymatlarni kritish kerak.

Maxsus optsiyalar Hover Button mulogot oynasining Custom tugmasi bilan
chagiriladi.

- Play Sound. Bu yerda tugma bosilganida yangrash kerak bo"lgan tovush
beriladi. Tovush fayllarini izlash uchun Bravse mulogot standarti ishlatiladi.

- Custom | mage (buyurtma tasviri). Bu tugmaga tanlangan tasvir beradi.

Harakatlanuvchi satrlar.

Harakatlanuvchi satrlar - bu HTML elementlaridir, u chegaraga harakatlanuvchi




matnlarni qo yishga imkon beradi; Harakatlanuvchi satrlar statik saxifalarni dinamik
va jonli saxifalarga aylantiradi. Saxifalarga harakatlanuvchi satrni joylashtirish uchun
quyidagi ishlarni qgilish kerak.

1. Kursor saxifaning harakatlanuvchi satr joylashishi kerak bo’lgan joyiga
o rnatiladi, undan Marguee bo’limi tanlanadi. Ekranda Marguee Properties
(harakatlanuvchi satr xossalari) murojaat oynasi paydo bo"ladi.

2.  Text maydonida harakatlanuvchi satr maydoni kiritiladi.

3. Direction (yo nalish) sektsiyasida satr harakati yo nalishi — Left (chapga) yoki
Right (ungga) ko rsatiladi.

4.  Movenment Speed (harakat tezligi) bo'limiga to xtash (Delay) va gadam
(Amount) giymatlari Kiritiladi.

5.  Bu giymatlarning xar xil giymatlari orgali satrni xar xil tezlik bilan
harakatlantirish mumkin.

6.  Behavior (xolat) bo'limiga quyidagi optsiyalardan biri tanlanadi:

Scrool (aylantirish);
Slide (siljish);

Alternate (navbat bilan).

7. Aligh with Text (matn joylashuvi) bo limida matn fazoda ganday joylashishi
kerakligi ko rsatiladi.
8. Sire bo'limida harakatlanuvchi satr uchun ajratilgan to rtburchakli soxa
o0 rnatiladi.
9. Repeat bo limida harakatlanishlar soni ko rsatiladi.
10. Background Color ochiluvchi ro’yxat orgali harakatlanuvchi fanga rang
beriladi.
11. OK tugma bosiladi va Marguee Properties mulogot oynasidan chigiladi.
Flash da animatsiyalar yaratish.
Shape Tweening usuli
Usul asosan ob’ekt formasi bir turdan ikkinchi turga o zgarishiga asoslangan.
Keyingi tugmasi orgali ushbu usul hakida batafsil ma’lumotga ega bo lishingiz
mumkin
1.1 - Qadam

Birinchi marta Oval (O) instrumenti yordamida aylana chizib olamiz. Ellips emas,




balki aylana hosil bo lishi uchun SHIFT tugmasi birgalikda bosib turiladi.

1.2-Qadam
Arrow (A) elementini ishlating va Timeline bo’limida 30 - kadrni belgilang.Bosh
menyudan Insert>Keyframe (F6) buyrug'ini bajaramiz. Bu harakat bilan siz 30 -
kadrni kalit kadrga aylantirdingiz. E’tibor bering lineyka ostiga kadrlar kulrang
rangda bo yalib koldi..

1.3 - Qadam
30 - kadrda Rectangle (R) instrumenti yordamida aylananing chap gismida
to rtburchak chizing.Arrow (A)instrumentini tanlang va aylanani belgilagan xolda
DELETE tugmasi yordamida uni o chirib tashlaymiz.

1.4 - Qadam
Sichgoncha tugmasini 1-30 kadrlar orasida ikki marta ishlating va hosil bo’lgan
paneldan Tweening bo’limini tanlang. Shape xolatini o rnatamiz.

1.5 - Qadam
1 - kadrda kursorni o'rnatgan xold, ENTER tugmasini bosing va hosil bolgan
animatsiyani ko'ring. Oxirgi natijani ko'rish uchun esa Control>Test Movie
(CTRL+ENTER) buyrug’ini bajaramiz.

Motion Tweening - usuli

Usul ob’ekt xususiyatlarini boshgarish uchun xizmat kiladi.. Eng oddiy
foydalanish sifatida koordinata o zgarishini keltirishimiz mumkin(Ya’ni harakat).

2.1-Qadam
1.1-Qadamdagi singari yangi fayl yarating va aylana chizing. Paint Bucket (U)
instrumenti yordamida ok-kora radial gradient bilan uning ichini bo’yaymiz.

2.2-Qadam
Ob’cktni belgilang (Insert>Select All (CTRL+A)) va bosh menyudan Insert>Convert
to Symbol... (F8) buyrug'ini bajaramiz. Name maydonida ob’ekta nomini bering:
ball.

2.3-Qadam
Belgilashni bekor gqilmay turib, Window>Inspectors>Object panelida quyidagi
parametrlarni o’rnatamiz: x=150, y=50, w=50, h=50




2.4-Qadam
61-kadrni kalit kadr giling

2.5-Qadam
Kadrlar orasida Sichgoncha tugmasini ikkimarta bosing, va paneldan Tweening
bo limini tanlang. Motion xolatini 0 rnatamiz.

2.6-Qadam
31-kadrni kalit kadr giling (F6).

2.7-Qadam
Ushbu kadrda ob’ektni tanlang va Object panelida y=250 koordinatasini o rnatamiz.
birinchi kadrda kursorni o rnatgan xolda, ENTER ni bosing va natijani ko ring.

2.8-Qadam
Tasavvurni to’lik hosil bolishi uchun 28 va 34 kadrlarni kilit kadr giling, shundan
so ng 31 - kadrda Window>Inspectors>Transform paneli yordamida koptokni vertikal
bo yicha gisqgartiring.(h =80% ).

Animatsion simvol yaratish
Macromedia Flash da ishni osonlashtirish va rolik o’lchamlarini yaxshilash uchun
simvol tushunchasi Kkiritilgan. Simvol quyidagicha bo'lishi mumkin: grafika
(Graphic), tugma (Button), animatsion rolik (Movie clip), tovush (Sound). Bu

imkoniyat yaratilgan ob’ektlar bir necha marta foydalanish imkonini beradi..

Yo'l bo'yicha harakat

4.1-Qadam
181 - kadrni kalit gilib, animatsiya vaqtini o rnatamiz.(F6).

4.2-Qadam
Insert>Layer buyrug'i yordamida yangi qatlam(sloy) vyarating va Pencil (P)
instrumentini faollashtiring.

4.3-Qadam
Yaratilgan chizigni sakrayotgan koptok uchun yo'l sifatida foydalanamiz. Chizikni
tanlang va Edit>Copy (CTRL+C) buyrug'i yordamida buferga oling. Shundan so 'ng,
ball_clip klipi gatlami uchun (bizda Layer 1) yul-gatlami(Guide:Layerl) yaratamiz.
Buning uchun Layer 1 ni tanlaymiz va bosh menyudan Insert>Motion Guide

buyrug'ini tanlaymiz. Guide: Layer 1 gatlamining birinchi kadrini tanlaymiz va




nusxalangan chizigni Edit>Paste in Place (CTRL+SHIFT+V) yordamida joyiga
kuyamiz.

4.4-Qadam
Layer 1 ning birinchi kadriga o'ting. ball clip ob’ektini tanlang.
Modify>Transform>Edit Center buyrug'i yordamida ob’ekta markazini o rnatamiz(+
belgisi). Ushbu amallarni oxirgi kadr uchun ham bir marta bajaramiz.

4.5-Qadam
Layer 1 ning birinchi va oxirgi kadrlari uchun Motion Tweening xolatini o rnatamiz
va Snap to Guide bayrokchasini tanlaymiz.

4.6-Qadam
ball_clip ob’ektini birinchi kadrda yo'l boshida va oxirgi kadrda yo'|l oxirida
0 rnatamiz.

4.7-Qadam
Yaratilgan animatsiyani ishlating(CTRL+ENTER) va biznig misol bilan

solishtiramiz.®

8 Sariev R.B. “Kompyuter grafikasi va dizayn” fanidan ma’ruzalar matni, tajriba va amaliy mashg ulotlar bo'yicha

uslubiy ko'rsatmalar. Bux. 2010 y.




2.3. Foydalanish ko rsatmasi.

Ushbu Elektron ma’lumotnomasidan foydalanish juda oson va oddiydir.
Komyuterda o rnatilgan istalgan tur brauzerda ochiadi va ishlashga tayyor bo’ladi.
Brauzerda ishlashi Elektron ma’lumotnomaning platforma tanlamasligini
ta’minlaydi. Ya’ni Microsoft Windows, Linux, Mac oilalariga kiruvchi operatsion
tizimlarmi yoki boshqa tizimlarmi brauzer bo’lsa kifoya, Elektron ma’lumotnoma
0 gib organishga tayyor bo ladi.

Elektron ma’lumotnoma “Bosh sahifa”, “Ma’ruzalar”, “Virtual mashg ulotlar”
“Test”, “’Yordam” menyularidan tashkil topgan. Birinchi navbatda brauzerda bosh

sahifa ochiladi.

C dascuriasn cii

Nast vl Havivte » Wihat! mavy) st * Tot » Fartan.

rishign bag isEimesn. o'n bitta mavan mashe"ulol, virtual mashg woltandan ibort. Har b mavay sazany ifodabamshi bian

Bosh sahifada ko rib turganimizdek yuqorida keltirilgan tarkibga mos

menyular joy olgan. “Mavzular” menyusida barcha 11 ta ma’ruzalar bilan
tanishishimiz mumkin. Buning uchun menyuga sichgonchani etib, ochilgan

bo limlarning birortasini ustiga chap tugmani bosish yetarli.
W Virtual mashg ulotlar « T

C agasturlash tining imkoniyatl va sintaks|
. Cdasturlash tlida o'zgaruvehl, konstanta va ularning - -
) koniyatlari va na
It C dasturlash tlida amallar

i C dasturlash Hhaa kirtish-chigarish funktsiyalarn "”““ talabatari (1

i Munosabat operatorlarl Hishda dasturlash
Takrorlanuvchi jarayonlar va takrorlanish operatoriar

a  Coasturash thos funkisiya chi C/C++ dastu

Magsivva ulami gayta Ishiash HI tual ln‘l';'llr:“]o

C dasturtash tilida ko'rsatgich va xotira tageimoti

Yangl uplar bilan Ishlash

C dasturlash tlining grank imkaniyatiarn




2MAVZU
C DASTURLASH TILIDA O'ZGARUVCHIL, KONSTANTA
VA ULARNING TIPLARI
Reja
1. O'2garuvehi. 0'2ganmas va ulaming ko'titdsl sohast
2. Ma lanotiaming tipi va ulami ¢ lon gilish
3. O'tkaziluveld tip o'zgamaviehilan

O'zgaruvehi, o'zgarmas va ulammg ko'rmish sohasi
C dastrulash tilida o'z2garuvchiar: oddiy, mdekish, ko'rsatkich, ob'ekr ko'rmishlarida bo'sshi mumiin,
Bu o'zgaruvchilamng to'rt turdag ko'rmish sohas: mavjud: lokal, tayl, dastur va sinf.
Lokal ko'rinish sohasida nomlar blokda ¢ lon qi¥nadi va shu blok doirasida foydalanish muskin, Bungs belgilar Kiemaydd, chunks ulami sha fnkisivaning @

gismida foydalanish mumkin, Funktsiya formal paramettiatining nomlar esa shu funkisiya blokidan tashqanida qanday  lon qiliigan bo'lsa shunday qurakdi,
Fayl ko'rinish solasida istslgan blok voli sinfda ¢'lon qilingan nomlar emas. balki ¢ lon gilingan joyidan keyin foydalanish mumkin.
Korib turganimizdek 3 —mavzuga o'tdik. Shu tartibda boshga mavzularniham
Kirib 0 rganish mumkin.
“Virtual mashg ulotlar” bo'limida ayrim murakkab tushunchalarni tashunish
uchun oddiy ko 'rgazmalar tayyorlanib qo"lyilgan. Masalan : 1- virtual mashg ulotga

kiramiz.

1-Virtual mashg ulotlar

Virtual mashg ulotlar -

2-Virtual mashg ulotlar

> de niyatlari va

3FVirtual mashg ulotlar
| 4-Virtual mashg ulotlar | .
aqa i talabalari
alar 5Virtual masha'ulotlar  |da dasturl;

for sikl operatorining ishlash prinsipi

Natija
For

s=0;
for(i-[l;la (i)
{

$++;
printf('%d', 5):
printf("\n');

)




Namoyon bo’lganidek, ushbu ko'rgazmada C tilidagi “for” sikl operatorining
ishlash prinsipi korib o"tishiniz mumkin. Buning uchun to’ldirish uchun

mo ljallangan maydonlarga giymatlar Kiritilsa yetarli.

s=0:

for {i@c
{

S ++;
nrintfi "L A e\

Natija tugmasi bosilganda sahifaning o'ng gismida joylashgan maydonga bosgichma

bosqich erishiladigan natijalar gayt etib boriladi.

| Natija
8=1->
§5=2->
§=3->
§S=4->
S=5-->
S=6-—>
§=7-->
§S=8-->
§=9->
S=10->

Ya’ni dasturda topilishi zarur bo'lgan sonlar yig indisining qiymati “S” soniga qanday
shakllantirilayotgani. Shu tartibda qolgan virtual ko rgazmalardan foydalanishimiz
mumkin.

Test menyusida siz ushbu mavzularga oid testlarni yechib 0"z bilimingizni sinab

ko rishingiz mumkin.




2.4. “C++ dasturlash tilida matematik amallar” o qitish texnologiyasi.

| Mavzu | C++ dasturlash tilida matematik amallar.

1.1.  Amaliy mashg ulotining o qitish texnologiyasi

Vaqti — 2 soat Talabalar soni: 26 nafar
0 quvsrﬁsing ulotining Mashglar va amaliy ishlar darsi.

Amaliy mashg ulotining
rejasi

C++ matematik amallar.
Amallar jadvali.
Razryadli amallar.

4. Oddiy masalalar yechish.

WN e

O quv mashg ulotining magsadi: C++ dasturlash tilida matemati amallarni
bajarish amaliyotiga ega bo'lish.

Pedagogik vazifalar:
- C++ dasturlash tilida
matematik amallardan ganday
foydalanishni tushuntirish;
-Matematik amallarni  tez
bajara  olish amalyotini
mustahkamlash;
- Xatoliklarni chetlab o'tish
usullarini o'rgatish;
- C++ dasturlash tilida
matematik masalalarni
yechish usullani o rgatish.

O quv faoliyatining natijalari:
Talaba:

- C++ dasturlash tilida matematik amallar ganday
ishlatilishi bo yicha bilimga ega bo’ladi;
- C++ dasturlash tilida matematik amallarni
barhasini oddiy usulda ishlata oladi;
-Matematik amallarni bajarishda operatorlarnni
0 zaro ishlata oladi;
-Matematik masalarni yecha ilsh.

O qitish uslubi va
texnikasi

blits -so"rov, kichik guruhlarda ishlash,
natijani tagdimot qilish.

O qitish vositalari:

Kompyuter, proektor, vizual materiallar,
informatsion ta'minot.

O qitish shakli:

Individual, juftlikda ishlash.

O qitish shart —sharoiti:

Proektor, komp’yuter bilan jihozlangan
auditoriya.




Informatika va axborot texnalogiyalari fanining texnologik xaritasi

Bosqichlar, Faoliyat mazmuni
vaqti O gituvchi O quvchi

1.1.0 quvchilarning darsga | Tinglaydi, savollar
tayyorgar-ligini tekshiradi. | beradi, tushunmagan
Mavzuning maqgsadi va vazifalarni | joylarini o gituvchidan

1-bosqich. e lon giladi, tushuntiradi. so raydi.

Kirish(10min.) | 1.2. Mavzuga kirish uchun oldingi | Tinglaydi, asosly
bilimlarni  faollashtiradi  (1-ilova). | ma'lumotlarni 0 zida
Savollar beradi. Mavzuga oid|gayd etib, yozib oladi,
gizigarli ma'lumotlar va yangiliklar | tushunmagan  joyla-rini
keltiradi. 0 gituvchidan so raydi.
2.1. Mavzuga motivatsiyani | Tinglaydilar, asosly
uyg’otadi. Mavzu bo'yicha asosiy | ma lumotlarni 0 zida

o quv materialini bayon
Maxsus fanlardan 0 quv
magqgsadlarini  to'g’ri  belgilash,
yo naltiruvchi, umumiy va aniq
0 quv magsadlari, ta'limiy,
tarbiyaviy hamda rivojlantiruvchi
o quv magsadlari hagida asosiy
tushunchalarni beradi.

giladi.

gayd etib yozib oladi.
Tushunmagan joyla-rini
0 gituvchidan so raydi.

2.2. Bilimlarni mustahkamlovchi | Munozarada ishtirok
savollarni kiritadi. Savol javoblar | etadi. Boshga
bo'yicha munozarani tashkil etadi | o quvchilar fikrini
2-bosqich. (2-ilova) tinglaydi, savollar
Asosiy gism beradi, javoblarini
(60min.) asoslaydi.
magsadlarini | 2.3. Har biri 4-5 kishidan iborat | Kichik guruhlar berilgan
eslatib o'tadi, | kichik guruhlarni shakllantiradi. Har | topshiriglar ustida
mavzuga oid | bir  kichik guruhga turli  xil | ishlay-dilar,
topshiriglar beradi (3-ilova). Ular | tushunmagan holatda
berilgan mavzular bo’yicha ta'limiy, | o gituvchidan  so raydi.
tarbiyaviy va rivojlantiruvchi o quv | Topshiriq natijalarini
magsadlarini  ishlab  chiqishlari | daftariga gayd qilishadi.
kerak. Tagdimot uchun material
tayyorlashadi.
2.4.Taqdimotni tashkil etadi, | Har bir guruh etakchisi
guruhlarni tinglaydi, savollar beradi. | topshiriglar natijalari
O quvchilarni  muzokaraga jalb | bo'yicha tagdimot
etadi. giladilar. Topshirigni
bajarishda bo'yicha yo’l
goyilgan xatolarni
tuzatadilar
3-bosqich. 3.1.Mavzu bo’yicha 0 quv | Tinglaydilar, savollar
Yakuniy go shimchalar, to’ldirishlarni bayon | beradi, yangi
(10 min.) giladi. Mavzu bo'yicha yakuniy | ma lumotlarni ozlariga




xulosani amalga oshiradi. | gqayd giladilar.

O quvchilarni baholaydi | O quvchilar mustagil ish
(4-ilova). Har bir kichik guruh | topshiriglarini yozib
uchun mustaqil ish topshiriglarini | oladilar.

beradi.

DARSNING O QUV-VIZUAL MATERIALLARI

1-ilova’

Ko'p programmalar ijro davomida arifmetik amallarni bajaradi. C++ dagi amallar
quyidagi jadvalda berilgan. Ular ikkita operand bilan ishlatildi.

C++ dagi amal Arifmetik operator Algebraik ifoda C++ dagi ifodasi:

Qo'shish + h+19 h+19
Ayirish - f-u f-u
Ko'paytirish * s s*|
Bo'lish / v/d, v/d

Modul olish % k mod 4 k%4

Bularning ba'zi birlarinig hususiyatlarini ko'rib chigaylik. Butun sonli bo'lishda,
yani bo'luvchi ham, bo'linuvchi ham butun son bo'lganda, javob butun son bo'ladi.
Javob yahlitlanmaydi, kasr gismi tashlanib yuborilib, butun gismining o'zi goladi.

Modul operatori (%) butun songa bo'lishdan kelib chigadigan qoldigni beradi.
x%y ifodasi x ni y ga bo'lgandan keyin chigadigan qoldigni beradi. Demak, 7%4 bizga
3 javobini beradi. % operatori fagat butun sonlar bilan ishlaydi. Vergulli (real) sonlar
bilan ishlash uchun "math.h™ kutubhonasidagi fmod funksiyasini qo’llash kerak.

C++ da gavslarning ma'nosi huddi algebradagidekdir. Undan tashgari boshga
boshqga algebraik ifodalarning ketma-ketligi ham odatdagidek. Oldin ko'paytirish,
bo'lish va modul olish operatorlari ijro ko'radi. Agar bir necha operator ketma-ket kelsa
ular chapdan o'nga garab ishlanadi. Bu operatorlardan keyin esa go'shish va ayirish ijro
etiladi.

Misol keltiraylik. kK=m*5+7%n /(9 + x);

Birinchi bo'lib m * 5 hisoblanadi. Keyin 7 % n topiladi va goldig (9 + x) ga
bo'linadi. Chiggan javob esa m * 5 ning javobiga qo'shiladi. Qisgasini aytsak, amallar
matematikadagi kabi. Lekin biz o'gishni osonlashtirish uchun va hato gilish ehtimolini
kamaytirish magsadida gavslarni kengroq ishlatishimiz mumkin. Yugoridagi misolimiz
quyidagi ko'rinishga ega bo'ladi.

k=(m*5)+((7%n)/(9+x));

Amallar jadvali

Arifmetik amallar | Razryadli Nisbat amallari Mantiqiy amallar
amallar

1. °Yuldashev Sh.S “Dasturlash tizimi” fanidan ma’ruzalar matni.




+ qo’shish & va == teng && va
- bo’lish | yoki = teng emas I yoki
* A inkor >  kata ! inkor
ko’paytirish
/ bo’lish << chapga | >= katta yoki

surish teng
% modul | >> o’ngga | <  Kkichik
olish surish
- unar minus | ~  inkor <= kichik yoki

teng

+ unar plyus
++ oshirish
kamaytirish

Amallar jadvali (davomi)

Imlo amallar Qiymat berish va | Tipli amallar Adresli amallar
shartli amallar

() — doirali gavs = - oddiy giymar | (tip) — tipni| & -  adresni
berish o’zgartirish aniglash

[] — kavadrat gavs | op= - murakkab | sizeof- hajmni | * - adres bo’yicha
giymat berish hisoblash giymat  aniqlash

yoki joylash
, - vergul ? — shartli amal

Arifmetik amallar. Amallar odatda unar ya’ni bitta operandga qo’llaniladigan
amallarga va binar ya’ni ikki operandga qo’llaniladigan amallarga ajratiladi.

Binar amallar additiv ya’ni + qo’shuv va — ayirish amallariga , hamda multiplikativ
ya’ni * kupaytirish, / bulish va % modul olish amallariga ajratiladi.

Additiv amallarining ustivorligi multiplikativ amallarining ustivorligidan
pastroqdir. Butun sonni butun songa bo’lganda natija butun songacha yahlitlanadi.
Misol uchun  20/3=6; (-20)/3=-6; 20/(-3)=-6.

Modul amali butun sonni butun songa bulishdan hosil buladigan goldikka
tengdir. Agar modul amali musbat operandlarga qo’llanilsa, natija ham musbat
bo’ladi, aks holda natija ishorasi kompilyatorga bog’likdir.

Binar arifmetik amallar bajarilganda tiplarni keltirish quyidagi qoidalar asosida
amalga oshiriladi:short va char tiplari int tipiga keltiriladi;

Agar operandlar biri long tipiga tegishli bo’lsa ikkinchi operand ham long
tipiga keltiriladi va natija ham long tipiga tegishli buladi;

Agar operandlar biri float tipiga tegishli bulsa ikkinchi operand kham float tipiga
keltiriladi va natija ham float tipiga tegishli buladi;

Agar operandlar biri double tipiga tegishli bo’lsa ikkinchi operand ham double tipiga
keltiriladi va natija ham double tipiga tegishli buladi;

Agar operandlar biri long double tipiga tegishli bo’lsa ikkinchi operand ham long
double tipiga keltiriladi va natija ham long double tipiga tegishli bo’ladi;




Ular amallarga ishorani o’zgartiruvchi unar minus — va unar + amallari Kiradi.
Bundan tashgari ++ va -- amallari ham unar amallarga kiradi.

++ unar amali qiymatni 1 ga oshirishni ko’rsatadi. Amalni prefiks ya’ni ++i
ko’rinishda ishlatish oldin o’zgaruvchi qiymatini oshirib so’ngra foydalanish
lozimligini, postfiks ya’ni i++ ko’rinishda ishlatish oldin o’zgaruvchi qiymatidan
foydalanib so’ngra oshirish kerakligini ko’rsatadi. Misol uchun i1 giymati 2 ga teng
bo’lsin, u holda 3+(++1) ifoda qiymati 6 ga, 3+i++ ifoda qiymati 5 ga teng bo’ladi.
Ikkala holda ham 1 qiymati 3 ga teng bo’ladi.

-- unar amali giymatni 1 ga kamaytirishni ko’rsatadi. Bu amal ham prefiks va postfiks
ko’rinishda ishlatilishi mumkin. Bu ikki amalni fagat o’zgaruvchilarga qo’llash
mumkindir. Ular amallarning ustivorligi binar amallardan yuqoridir.

Razryadli amallar. Razryadli amallar natijasi butun sonlarni ikkilik
ko’rinishlarining har bir razryadiga mos mantikiy amallarni qo’llashdan hosil bo’ladi.
Masalan 5 kodi 101 ga teng va 6 kodi 110 ga teng.

6&5 qiyjmati 4 gaya’ni 100 ga teng.

6|5 qiyyjmati 7 gaya’ni 111 ga teng.

6”5 giymati 3 gaya’ni 011 ga teng.

~6 kiyjmati 4 ga yajhni 010 gateng.

Bu misollarda amallar ustivorligi oshib borishi tartibida berilgandir.

Bu amallardan tashgari M<<N chapga razryadli siljitish va M>>N ungga razryadli
siljitish amallari qo’llaniladi. Siljitish M butun sonning razryadli ko’rinishiga
go’llaniladi. N nechta pozitsiyaga siljitish kerakligini ko’rsatadi.

Chapga N pozitsiyaga surish bu operand giymatini ikkining N chi daraasiga
kupaytirishga mos keladi. Misol uchun 5<<2=20. Bu amalning bitli ko rinishi:
101<<2=10100.

Agar operand musbat bulsa N poziciyaga ungga surish chap operandni ikkining
N chi darajasiga bo’lib kasr qismini tashlab yuborishga mosdir. Misol uchun 5>>2=1.
Bu amalning bitli ko'rinishi 101>>2=001=1. Agarda operand giymati manfiy bulsa
ikki variant mavjuddir: arifmetik siljitishda bushatilayotgan razryadlar ishora razryadi
qiymati bilan to’ldiriladi, mantiqiy siljitishda bushatilayotgan razryadlar nullar bilan
tuldiriladi.

Razryadli surish amallarining ustivorligi o’zaro teng, razryadli inkor amalidan
past, golgan razryadli amallardan yugoridir. Razryadli inkor amali unar golgan
amallar binar amallarga kiradi.

Nisbat amallari. Nisbat amallari giymatlari 1 ga teng agar nisbat bajarilsa va
aksincha 0 ga tengdir. Nisbat amallari arifmetik tipdagi operandlarga yoki
ko’rsatkichlarga qo’llaniladi.

Misollar:

11=0 giymati 1 ga teng;

1==0 giymati O ga teng;

3>=3 giymati 1 ga teng;

3>3 giymati 0 ga teng;

2<=2 giymati 1 ga teng;

2<2 qiymati 0 ga teng;

Katta >, kichik <, katta eki teng >=, kichik eki teng <= amallarining ustivorligi bir
xildir.

Teng == va teng emas != amallarining ustivorligi uzaro teng va qolgan amallardan
pastdir.




Mantiqgiy amallar. C ++ tilida mantigiy tip yukdir. Shuning uchun mantiqiy
amallarni butun sonlarga qo’llanadi. Bu amallarning natijalari qo’yidagicha
aniglanadi:

X|ly amali 1 ga teng agar x>0 eki y>0 bo’lsa, aksincha 0 ga teng Xx&&y amali 1 ga
teng agar x>0 va y>0 bo’lsa, aksincha 0 ga teng !x amali 1 ga teng agar x>0 bulsa,
aksincha 0 ga teng. Bu misollarda amallar ustivorligi oshib borish tartibida
berilgandir.

Inkor ! amali unar kolganlari binar amallardir. Bu amallardan tashgari quyidagi
amallar ham mavjuddir: Qiymat berish amali. Qiymat berish amali = binar amal
bo’lib chap operandi odatda o’zgaruvchi ung operandi odatda ifodaga teng bo’ladi.
Misol uchun Z=4.7+3.34 Bu qgiymati 8.04 ga teng ifodadir. Bu gqiymat Z
o’zgaruvchiga ham beriladi.

Bu ifoda ohiriga nugta vergul ; belgisi quyilganda operatorga aylanadi.

Z=4.7+3.34 Bitta ifodada bir necha giymat berish amallari qo’llanilishi mumkin.
Misol uchun: C=y=f=4.2+2.8;

Bundan tashqari C ++ tili da murakkab qiymat berish amali mavjud bo’lib,
umumiy ko’rinishi quyidagichadir: O’zgaruvchi_nomi amal= ifoda;
Bu erda amal quyidagi amallardan biri *,/,%,+,-, &, <<,>>.
Misol uchun:

X+=4 ifoda x=x+4 ifodaga ekvivalentdir;

X*=a ifoda x=x*a ifodaga ekvivalentdir;

X/=a+b ifoda x=x/(a+b) ifodaga ekvivalentdir;

X>>=4 ifoda x=x>>4 ifodaga ekvivalentdir;

Imlo belgilari amal sifatida. C ++ tilida ba’zi bir imlo belgilari ham amal sifatida
ishlatilishi mumkin. Bu belgilardan oddiy () va kvadrat [] gavslardir. Oddiy gavslar
binar amal deb qaralib ifodalarda yoki funktsiyaga muroaat gilishda foydalaniladi.
Funktsiyaga murojaat qilish qo’yjidagi shaklda amalga oshiriladi:

<funktsiya nomi> (<argumentlar ruyhati>). Misol uchun sin(x) eki max(a,b).

Kvadrat gavslardan massivlarga murojaat gilishda foydalaniladi. Bu murojaat
quyidagicha amalga oshiriladi:
<massiv nomi>[<indeks>]. Misol uchun a[5] eki b[n][m].

Vergul simvolini ajratuvchi belgi deb ham garash mumkin amal sifatida ham
garash mumkin. Vergul bilan ajratilgan amallar ketma-ketligi bir amal deb garalib,
chapdan o’ngga hisoblanadi va ohirgi ifoda qiymati natija deb qaraladi. Misol uchun:
d=4,d+2 amali natijasi 8 ga teng.

Shartli amal. Shartli amal ternar amal deyiladi va uchta operanddan iborat

bo’ladi: <1-ifoda>?<2-ifoda>:<3-ifoda>
Shartli amal bajarilganda avval 1- ifoda hisoblanadi. Agar 1-ifoda giymati O dan farqli
bo’lsa 2- ifoda hisoblanadi va qiymati natija sifatida gabul gilinadi, aks holda 3-ifoda
hisoblanadi va giymati natija sifatida gabul gilinadi.
Misol uchun modulni hisoblash: x<0?-x:x yoki ikkita son kichigini hisoblash a<b?a:b
Shuni aytish lozimki shartli ifodadan har ganday ifoda sifatida foydalanish mumekin.
Agar F FLOAT tipga,a N — INT tipga tegishli bo’lsa, (N > 0) ? F : N ifoda N musbat
eki manfiyligidan qat’iy nazar DOUBLE tipiga tegishli bo’ladi. Shartli ifodada
birinchi ifodani gavsga olish shart emas.

Tiplar bilan ishlovchi amallar. Tiplarni o’zgartirish amali quyidagi ko’rinishga
ega: (tip_nomi) operand; Bu amal operandlar giymatini ko’rsatilgan tipga keltirish
uchun ishlatiladi. Operand sifatida kostanta, o’zgaruvchi yoki gavslarga olinga ifoda




kelishi mumkin. Misol uchun (long)6 amali konstanta qiymatini o’zgartirmagan holda
operativ hotirada egallagan baytlar sonini oshiradi. Bu misolda konstanta tipi
o’zgarmagan bo’lsa, (double) 6 eki (float) 6 amali konstanta ichki ko’rinishini ham
o’zgartiradi. Katta butun sonlar hakikiy tipga keltirilganda sonning aniqligi yugolishi
mumkin.

sizeof amali operand sifatida ko’rsatilgan ob’ektning baytlarda hotiradagi hajmini
hisoblash uchun ishlatiladi. Bu amalning ikki ko’rinishi mavjud:

sizeof ifoda sizeof (tip) Misol uchun:

Sizeof 3.14=8
Sizeof 3.14f=4
Sizeof 3.14L=10
Sizeof(char)=1
Sizeof(double)=8.

Amallar ustivorligi

Rang | Amallar Yo’nalish
1 ofng-> . Chapdan o’ngga
2 I ~ + - ++ -- & * (tip) | O’ngdan chapga
sizeof new delete tip()
3 K> Chapdan o’ngga
4 * | % (multiplikativ binar | Chapdan o’ngga
amallar)
5 + - (additiv binar amallar) Chapdan o’ngga
6 << >> Chapdan o’ngga
7 < <= >= > Chapdan o’ngga
8 = I= Chapdan o’ngga
9 & Chapdan o’ngga
10 N Chapdan o’ngga
11 | Chapdan o’ngga
12 && Chapdan o’ngga
13 | Chapdan o’ngga
14 ?:(shartli amal) Chapdan o’ngga
15 = *= = %= += -= = | Chapdan o’ngga
N= |: <<= >S>=
16 , (vergul amali) Chapdan o’ngga

2-ilova
Bilimlarni mustahkamlash uchun savollar:

C++ da matematik amallar deganda nimani tushunasiz;

Metematik amallar sintaksisi deganda nimani tushunasiz;

Ma’lumot tiplari bilan matematik amallarni munosabani tushuntiring;
Amallar ustuvorligi tushutirib bering;

Razryadli amallar atamasi tariflang;

agbhwnE




3-ilova

Kichik guruhlarda ishlash uchun topshiriglar:

1-guruh:
1. 2*+5*7 matetik masalasi dasturini tuzung:
2. log,*+6° matetik masalasi dasturini tuzung.

2-guruh:
1. 6°+3/2 matetik masalasi dasturini tuzung;
2. logs’+8/3 matetik masalasi dasturini tuzung

3-guruh:
1. 5°+9-2 matetik masalasi dasturini tuzung;
2. logs®+6/3-2 matetik masalasi dasturini tuzung

4-ilova

Nazariy bilimlarni baxolash mezonlari

Baho Ball O quvchilarning bilim darajasi
5(A’lo) 86-100 % 1. Barcha savollarga javob bersa.
2. Darsda faol ishtirok etsa.
3. Mavzuni yaxshi 0 zlashtirsa.

4 (Yaxshi) 71-85 % 1. Savollarga javob bersa.
2. Darsda ishtirok etsa.
3. Mavzuni o zlashtirsa.

3 (Qoniqarli) 55-70% 1. Qisman savollarga javob bersa.
Darsda ishtirok etsa.
3. Mavzuni o zlashtirsa.

N

2 (Qonigarsiz) 0-54 % 1. Barcha savollarga javob bermasa.
Darsda ishtirok etmasa.
3. Mavzuni o zlashtirmasa.

N




11 — Bob. Mexnatni muxofaza qilish.

3.1. Tashkilotlar va korxonalarda, xalq ta’limi sistemasida mexnat muxofazasiga

oid ishlarni tashkil gilish.

Korxona va tashkilotlar mexnat muxofazasining umumiy xolatiga uning
direktorlari, boshliklari javob beradilar. Ishlab chigarish soxalarida mexnat
sharoitlarini yaxshilash va xavfsizlikni ta’minlash maksadida xavfsizlik texnikasi

xizmati kuzda tutilgan.

Xavfsizlik texnikasi xizmatining asosiy vazifalari tashkilot va korxonalarda
ishlab chigarish travmatizmi sabablarini bartaraf etish ishlarini bajarish, mexnat
sharoitlarini yaxshilash, xavfsizlik texnikasi va ximoya vositalarini takomillashtirish,
ishlab chigarish madaniyatini ko tarish, tashkiliy-texnik va sanitariya-gigiena
tadbirlarini ishlab chigish va amalga oshirish bo yicha ishlab chigarish va texnik

xizmatlarning ishini nazorat gilishdan iborat .

Tashkilotlarda va gishlog xo jalik korxonalarida mexnat muxofazasi, xavfsizlik
texnikasi va yong indan muxofaza gilishni tashkil gilish bo"yicha injenerlik lavozimi

bor.

Bu injenerning vazifasiga korxona ishchilariga xavfsizlik texnikasi va ishlab
chigarish sanitariyasidan ta’lim berishni tashkil gilishda ishtirok gilish va ularning
bilimlarini tekshirish kiradi. U jamoaning kasaba uyushmasi bilan birgalikda mexnat
sharoitini yaxshilashga oid tadbirlar ishlab chigadi va ularning bajarilish chorasini
ko radi.

Mexnat muxofazasi bo'yicha injener ishlab chigarish bilan bog lik bo"lgan
baxtsiz xodisalar yuz bergan vaziyatni va uning sabablarini tekshirishda ishtirok etadi,
travmatizm tug risida hisobotlar tuzadi, uning sabablarini o’rganadi va ularni bartaraf

qgilish choralarini ishlab chigadi.

Xalqg ta’limi sistemasida mexnat muxofazasining umumiy xolati, 0" quv

muassasalarining raxbarlariga yuklatiladi. Ular quyidagilarni tashkil gilishi kerak.

- butun o’quv protsessida o quvchilarning xavfsizligini ta’minlash;




- maktabda, litseyda va kollejlarda xavfsizlik texnikasi bo’yicha plakatlar,
instruktsiyalar va boshka normativ xujjatlar bilan ta’minlash;

- ishlab chigarishda va o'quv protsessida sodir bo'lgan baxtsiz xodisalarni
tekshirishni tashkil gilish va unga sabab bo’lgan kamchiliklarni tuzatish.

- har ganday og'ir yoki gruhli baxtsiz xodisalarni tezda viloyat xalg ta’limi
boshgarmasiga, prokuraturaga va viloyat kasaba uyushmasiga xabar yetkazishni
tashkil qgilish kerak;

- kasaba uyushma bilan birgalikda har chorakda mexnat muxofazasi bo'yicha
tadbirlarning bajarilishini tekshirib boradi;

- mexnat muxofazasi xolati bo'yicha javob beruvchi shaxsning hisoboti
tinchlanadi va sodir bo Igan kamchiliklar tuzatilib boriladi;

- doimo o quv xonalarning xavo iglimi, changlanganlik va zaxarli gazlarning bor-
yukligi tekshirilishini shuningdek dizenfektsiya gilishni tashkil kiladi;

- xar vyili elektroustanovkalarning yerga ulanishini, izolyatsiyasini tekshirtirib
boradi;

- 0z vaqtida o quv xonalarning remontini tashkil kiladi (potolok, pollar va
hokazolar).

Mexnat xavfsizligi xamma ishchi-xodimlarning, talabalarning va
0 quvchilarning xavfsizlik goidalarini bilishlariga goida. Shuning uchun ishga yangi
gabul gilingan barcha ishchilar ish o rinlarida Kirish instruktaji va birlamchi
instruktajdan o tganlaridan keyingina ishga go yilishlari mumkin. Bundan tashqari
davriy instruktaj, plandan tashgari instruktaj, qo shimcha instruktaj va oylik o kish

kurslardan iborat.

Kirish instruktajini tegishli soxaning bosh mutaxassisi 0 tgazadi. U mexnat
muxofazasiga oid qonunchilik to"g risidagi asosiy ma’lumotlarni, ichki tartib-qoidalar
va korxonadagi xavfsizlik qoidalari to'g risida gapirib beradi. Kirish instruktaji suxbat
yoki lektsiya tarzida otiladi. Kirish instruktajini o tishda ko prok texnika asboblari,
ko rgazmali qurollar yordamida otish kerak. Instruktaj o tgandan keyin albatta jurnal
tutish kerak va bu jurnalga o quvchilar va talabalar instruktaj o tganligi hakida go’l
qo yishi kerak.

Birlamchi instruktajni o qituvchi yoki uchastka boshligi xar bir talaba bilan

yoki ishchi bilan olib boradi. Birlamchi instruktajga ishchining o"z ixtisosligi




bo’yicha vazifalari, ish urnini xavfsiz tashkil gilish tartibi bilan tanishtirish, asbob-
uskuna va ximoya vositalarini ishlatish xamda ulardan foydalanish goidalari, xavfsiz
ishlash usullari, yong inni uchirish vositalari va signalizatsiyaning turar joyi xamda
ishlatish usullarini, shuningdek, xavf tugilgan tagdirda o"zini ganday tutish kerakligi
bilan tanishtiriladi. Instruktaj o tuvchi ishchining yoki talabaning xavfsizlik goidalari
bo yicha bilimini tekshirib ko'radi, agar u mexnat muxofazasining asosiy talablarini,
goidalarini o'rgangan bo’lsa uni ishlashga ruxsat beradi va jurnalga gayd qilib

go yadi.

Davriy instruktaj — ishchi-xodimlarga va talabalarga kamida yarim yilda bir
marta ish joyida o tqaziladi. Uning maksadi — ishchilarning xotirasida xavfsizlik
texnikasi va yong inga karshi kurashish goidalaridan bilimlarini mustaxkamlash
uchun, xamda elektroustanovkalarga xizmat ko rsatuvchi xodimlar uchun esa kamida

3 oyda bir marta bevosita ish o’rinlarida o tgaziladi.

Rejadan tashqari instruktaj — xavfsizlik goidalari yoki asbob-uskuna va
xavfsiz ishlashga ta’sir giluvchi boshka xar ganday faktorlar o zgarganida,
shuningdek, biror xodim tomonidan travma, avariya yoki yong'in chigishiga olib

keladigan darajada xavfsizlik qoidalari buzilganda o tqaziladi.

Qo’'shimcha instruktaj esa baxtsiz xodisadan keyin, so nggi instruktaj berilgan

sanadan qgat’i nazar xamma ishlovchilar bilan o tgaziladi.

Oylik o kish kurslarida kuchlanishi 1000 V va undan yuqori bo"lgan
elektroustanovkalarga xizmat ko rsatuvchi xodimlar, balandlikda ishlovchi
montajchilar, izolyatsiyalovchilar, elektr-gaz payvandchilar va yuqori xavf manbaida
ishlaydigan ishchilar o"qiydi. Ular tashkilot bosh injeneri tasdiklagan programma
asosida ishlarning xavfsiz usullari va gabullariga o qitadi. O qitish tugagandan so'ng
ishchining ko rsatilgan ishlarning usullari va ishlab chigarish sanitariyasi talablarini

0 zlashtirganligi yuzasidan olgan bilimi tekshirilib, unga guvoxnoma beriladi.




3.2.  Kompyuter xonasiga bo'lgan gigienik talablar va uning yoritilishi.

Foydalanuvchini EXM ishchi stolida to'g'ri o'tqazish organlar va organizm
sistemasining normal ishlashiga sharoit yaratib, umurtka pog onasi buzilishining, kuz
nuri pasayishining oldini olishga, sog ligni va yaxshi mexnat qobiliyatini saglashga
yordam beradi. Bu magsadda, foydalanuvchining poyafzal bilan birgalikdagi boyi
uzunligiga mos ravishda stol va stullar tanlanishi kerak.

Foydalanuvchi vidiomonitor ro parasidan bukilmasdan to'g'ri burchak hosil
gilishi va Klaviaturali stol qiya sirtiga tayanishiga, bu bilan yelka va kul
mushaklaridagi statik tolikishning oldi olinadi. Stol o’tirgichining girrasi stolning
foydalanuvchi tomonidagi kirrasidan 5-7 sm ichkari kirishi kerak, tizza va boldir bilan
hosil kilinadigan burchak 90 - 120° gradus bo'lishi, oyoq poshnalari pol yoki oyoglar,
uchun go'yilgan vositaga tiralishi mumkin. Bosh oldinga 15° dan ko'p bo’Imagan
burchak bilan oldinga egilishi mumkin.

Foydalanuvchi nigohi vidiomonitor ekrani o'rtasidan xayolan o'tgazilgan
vertikal yuzadan 10° dan ortik bo’Imagan chetlanishga ega bo’lishi kerak.

Ko’z darajasi vidiomonitor ekrani balandligining markazida, ekran markazidan
0°tuvchi gorizontal yuzadan optimal ko'rish, 15° chegarasida, chegaraviy ko'rish, 30°
bolishi kerak. Videomonitor ekrani cheka nuqgtalaridagi axborotni ko'rishdagi, nigoh
chizig'i va ekranning chap yoki o'ng kirralaridagi axborotni garash burchagi 45° dan
kichik bo"Imasligi kerak.

Foydalanuvchining ko zining monitor ekranigacha optimal masofasi 60 -70 sm,
hech bo’Imaganda 50 sm dan kam bo Imasligi kerak. Ekrangacha 50 sm dan kichik
masofaga ishlash tavsiya etilmaydi, chunki bu ko zning tez charchashiga, gizarishga,
achishiga va hokazolarga olib keladi, keyinchalik esa bu holat normal bo'lishiga, fakat
yagindagina ko'ra oladiganlarga esa kasallikning kuchayishiga olib keladi. O’rtq
darajadagi yagindan yoki uzoqgdan ko'ra oladigan foydalanuvchilar vidiomonitorda
ishlashda EXM ekranida 60 - 70 sm masofaga axborotni ajrata olish uchun ko rishni
tiklovchi kuzoynaklarda ishlashlari kerak.

Bunda EXM ekranida belgilarni karash burchagi 20 burchakli minutlardan kam

bo Imasligi kerak.




EXMdan foydalanib, mashg'ulotlar  o'tgazishning  samarali  rejimi
videomonitorda uzluksiz ishlashning belgilangan uzunligiga, tanaffuslarga,
shuninndek foydalanuvchilar sog ligini ximoya gilishga yo naltirilgan profilaktik
tadbirlarni rioya qgilishni talab giladi. Sharoitlarga, ishchi o rinlarni tashkil gilinishiga,
foydalanuvchilarni o'tgazishga bo'ladigan gigienik talablarga rioya gilgan xolda
EXMda ishlash vaqtining uzunligi, foydalanuvchining yoshi ishni boshlash vaqti,
tanaffuslar uzunligi, shunungdek ularning konstruktivlik xususiyatlari bilan bog lik
boladi.

Dars vaqtida bir yo nalishga karatilgan jismoniy tanaffuslar o"tgazish mumkin.

Darslar o'rtasidagi tanaffus 10 minutdan kam bo’Imasligi kerak. Oliy o’'quv
yurtlarida vaqgtning 50 % ni nazorat mashg ulotlariga va 50 % ini Amaliy
mashg ulotlarga ajratish kerak.

Ish rejimi profilaktik tadbirlar o"tgazish talablariga mos ravishda tashkil gilish
kerak.

Talabalarning darsdan tashgari EXMda ishlash vaqti 3 soat bilan, 16 yoshdan
kichik bo"lganlar uchun 2 soat bilan cheklangan bo’lishi kerak.

Talabalarning darsdan tashgari EXMda ishlash vaqgti 3 soat bilan cheklangan
bolishi kerak.

Bunda profilaktik tadbirlar o’tgaziladigan ish rejimiga rioya gilishi kerak.

Koz uchun mashglar xar 20 -25 minutdan keyin fizik mashklar, 45 minutdan
keyin tanaffus vaqtida bajarilishi kerak.

EXMda go shimcha ish vaqti o’quv mashgulotlari tugaganidan keyin 1 soatdan
kam bo’Imagan vaqtda tashkil gilinishi kerak. Bu vagt dam olish va ovgatlanish uchun
ajratilishi kerak. Bunday tanaffusdan keyin foydalanuvchining funktsional xolati
mashgulotlarning 1 — darajasigacha bo ladigan xolatiga yaginrog darajada tiklanadi.

Kuz uchun, organizm uchun belgilangan mashklar tanaffuslar e’tiborsiz karash
mumkin emas, chunki ularni o'tgazish, ko rish analizatori, markaziy asab, yurak tomir,
nafas, mushak va organizmning boshka sistemalari funktsional xolatini yaxshilaydi,
tananing kuyi yarmidagi, oyoqdagi, otirib ishlash natijasida hosil bo"ladigan uyushib
qgolish xolatlarini yugotishga yordam beradi, miya gon aylanishni yaxshilaydi.

Kompyuter xonasining jixozi 10-15 tagacha Shaxsiy kompyuter (0 quvchining
ish joyi) va bitta o gituvchi ish joyidan tashkil topadi. Xonaning tarkibiy gismi-




orgtexnika va "Kompyuter savodxonligi asoslari” fani bo’yicha nazariy va amaliy|
darslar, darsdan tashgari fakultativ mashgulotlar o'tkazish uchun xizmat giladi.
Xamma o quvchilar va o gituvchilar, to'garak a’zolari va boshga foydalanuvchilar,
Shaxsiy kompyuterda ishlashdan avval majburiy ravishda texnika xavfsizligi bo yicha
ko rsatmalar bilan tanishgan va bu 0°z navbatida jurnalda gayd etilgan bolishi kerak.

Ushbu mashg ulot o quvchi salomatligiga bevosita bog'liq bo lganligi uchun
quyidagi ko'rsatmalarni xamma o quvchilarga tanishtirib, imzolatib qo’yishni tavsiya
etamiz. Matn kompyuter xonasining ko'rinarli joyiga o'sib go'yilishi magsadga
muvofiq.

Xonadagi xavo xarorati o rtacha 20-24° C atrofida bolishi lozim.

O quvchilarining shaxsiy kompyuter bilan uzluksiz ishlash vaqgti bir kun
davomida 4 soatdan oshmasligi tavsiya etiladi. O quvchi kompyuterdan eng kamida 40
sm narida o tirishi kerak.

Agar bino bir gavatli bo’Imasa, kompyuter xonasi birinchi va oxirgi gavatlarda
bo'Imagani ma’qul. Birinchi gavatda shovgin-suron tovush eshitilishi, chang-to'zon
tushishi hamda o girlik sodir etilishiga qulay sharoitlar mavjud bo"lishi mumkin. Eng
Yugori gavatda bo'lsa ham gaznoq orgali o'gri tushishi, qor-yomgir suvlari o tishi,
quyosh nuri tik tushib, xona haroratini ko tarib yuborishi mumkin.

Kompyuterlar o'rnatilgan xona polli, devorlar suv qgo'shib ishlatiladigan
bo'yoqda bo'yalgan, albatta erga ulangan signallashtirilgan, eshik va oynalar temir
panjaralar bilan mahkamlangan bo'lishi shart. Butun xona EHM xonasiga mos
ravishda jihozlangan bo lishi kerak.

Kompyuter xonalariga quyosh nuri tik tushadigan bo'lsa, oynalarda xonani
gorongilashtiruvchi gora darpardalar ham bo’lishi lozim. Kompyuterlarning barcha
qurilmalari giloflar bilan qoplangan holda turishi kerak. Xonada haroratni o'lchab
turuvchi xona termometri, kompyuterlar uchun himoya oynalari bo"lishi zarur, xonada
20-24 gradusli (ko pi bilan 28 gradusgacha) temperatura saglanishi lozim. Agar xona
harorati keragidan oshib ketsa yoki pasayib ketadigan bo’lsa, xona xaroratini
mo tadillashtirib turuvchi konditsioner bo"lishi magsadga muvofiqdir. Xonada kaktus,
aloy kabi tikanli o’simliklarning bo'lishi inson salomatligi uchun foydali.

Kompyuterdan foydalanuvchi har bir shaxs texnika xavfsizligi qoidalaridan

xabardor bo'Imogi lozim. Ochiq simlar, ochiq yoki noqulay rozetkalar bilan




ishlamaslik kerak, inson salomatligiga xavf tug diruvchi biror hid yoki boshga biror
belgi sezilsa, darhol rahbarni xabardor gilish kerak. Imkoniyat bo"lsa, kompyuterdan

foydalanuvchilar oq xalat kiyib shugullansalar, magsadga muvofiq bo'ladi.*

1. 0.D.Raximov, U. Yuldoshev «Mexnatni muxofaza qilish» ma’ruzalar matni Toshkent-2008.




3.3. EXM xonasi harorati va namligi.

EXMda ishlash kislorodning kontsentratsiyalanishi pasayishiga, azonning
ko payishiga bu esa 0'z navbatida xavo atmosferasi tarkibidagi azonning chegaraviy
giymatlaridan xam oshishiga olib kelishi mumkin. Xavoning ionli tarkibi buziladi.
O'quv xonasida agar kompyuterlar yogilgan va xech kim bo’lmasa, manfiy ionlar
miqgdori chegaraviy giymatdan oshib ketishi mumkin, bu esa odamlar kayfiyatini
yomonlashuviga, bosh ogrigining paydo bo'lishiga, ishlash kobiliyatining pasayishiga
olib kelishi mumkin.

Xavo tarkibidagi ionlarning mumkin bo"lgan chegaralari quyidagicha:

1. Xonada foydalanuvchilar bo'lsa, xavo organik tabiatli antropogen moddalar va
uglerod dioksidi Bilan ifodalanadi. Shu sababli EXMni xonalarda xama iglimiy,
sohalar uchun optimal xarorat namlik rejimini ta’minlovchi ogimli suruvchi
ventelyatsiyaga ega bo'lish tavsiya etiladi.

2. Xarorat va nisbiy namlikning optimal va chegaraviy paprametrlari.

Okimli  suruvchi ventelyatsiya bo'lmagan vaqgtda xavoning maishiy
konditsionerlarning unumdorligiga ~ mashinalardan, odamlardan, kuyosh
radiatsiyasidan, sun’iy yoritish manbalaridan bo’ladigan ortikcha issiklik mikdoriga
bog'lik ravishda o'rnatiladigan konditsionerlarning sonini hisoblash mumkin.
Hisoblashlar ventelyatsiyalar bo’yicha muxandis tomonidan hisoblanishi kerak.
Konditsionerlar me’yor giymatidan oshmaydigan shovqginni hosil gilmasligi kerak.
Konditsionerlar ishlayotgan vaqtda xona eshiklari yopiq bo’lishi kerak. Ogqimli
suruvchi ventelyatsiya va konditsionerlar bo Imagan vaqtda xonani xar bir tanaffusda
va xar gqanday xavoda shamollatishni tashkil etib turish kerak. Agar ob-xavo sharoitlari
yo'| go'ysa, darslarni ochik derazalari xonada xam o tgazish mumkin.

EXM Ili xonalar yuqori shovkinli va vibratsiyali xonalardan (mashina zallari,
gimnastika zallar, musiga maxsulotlari uchun kabinetlar, ustoxonalar va x.Kk.)
shuningdek kucha magistrallaridan, katta transport gatnovi ko chalaridan uzoqroq
bo'lishi kerak. EXM xonalarida shovqin darajasi 40, xavo isitish tizimi, ventelyatsiya
va konditsioner ishlaganda esa 35, o'quv mashgulotlari vagtida esa shovgin 50 dan

oshmasligi kerak.




Shovginni pasaytirish maksadida EXMIi xonalarda 63 - 8000 Gts chastotali
soxada tovushni yo'tuvchi yuqori samarali materiallar ishlatilishi mumkin. Xonada
tovushni yo'tuvchi qo'shimcha vosita bo’lib derazalardagi og'ir, zich darpardalar
xizmat gilishi mumkin.

Ular devordan 15 — 20 sm masofada osilgan bo’lishi kerak. Bunday parda eni
deraza enidan 2 marta Kkatta, bir xil rangda va o quv xonasi rangi bilan mos tushgan
bolishi kerak.

Har xil polimer materiallar ishlatilgan EXMIi xonalarda olib borilgan gigienik
tadkikotlar shuni ko rsatadiki, xavoga xar xil fenol, formaldegid, xlorli vinil ammiak,
toluol, hokazolarga ega ekan. Ular mumkin bo’lgan chegaraviy ta’sir ko rsatish, uning
mexnat qobiliatini pasaytirish mumkin. Havo xaroratining oshishi xona havo
muxitidan ximik moddalarning mavjudligi bir xil darajada sezilmaydigan yogimsiz xid
tug diradi. Bu moddalar kontsentratsiyasi ob — xavo sharoitlari, tashgaridagi havo
xarorati, atmosfera bosimi, shamolning tezligi va xona derazalariga yo nalishi va
hokazolar bilan aniglanadi. Yomg'irli ob - xavoda tashkqgi havo haroratining
ko tarilishida suruvchi ventelyatsiya ishi yomonlashadi.

Shu sabalarga ko'ra, EXMIi xonalar devorlarini bezashda xavoga zararli ximik
moddalar va birlashmalar ajratuvchi sintez sintetik matiriallardan foydalanishga yo'l

ko ymaydi.




XULOSA

Mening bitiruv malakaviy ishimning mavzusi “C dasturlash tili  dasturi
bo'yicha Elektron ma’lumotnoma Yyaratish” bo'lib, ushbu dasdur bo’yicha Microsoft
FrontPage, Delphi va Macromedia Flash texnologiyasi asosida Elektron
ma’lumotnoma yaratdim.

Xozirgi davrda zamonaviy o qitish texnologiyalari jadal o'sib borayotgan bir
pallada o"qitish jarayonida elektron nashrlardan keng foydalanish alohida axamiyat
kasb etadi. O qgitishni bu usulda tashkil etilishi ko proq tajriba, amaliy va mustaqil
mashg ulotlarda qo’l keladi. Ya’ni talaba ma’lum sabablar bilan biror mavzuni
0 zlashtirolmagan bo’lsa, u mustakil xolda ushbu Elektron ma’lumotnomadan
foydalanib, goldirgan darsini oson tushunishi mumkin bo"ladi.

Elektron ma’lumotnomani yaratish jarayonini ikki bosgichda amalga oshirdim:

1. Elektron ma’lumotnoma uchun kerak bo'ladigan nazariy ma’lumotlarni
yig dim va gayta ishladim.

2. Har bir mavzu bo'yicha Elektron ma’lumotnoma sahnalarini, sahnalar
tarkibida navigatsion tugmalarni, bosh oyna dizayni va boshga oynalar bilan alogasini
yaratdim.

Elektron ma’lumotnomani institut «Informatika va axborot texnologiyalari»
kafedrasi, litsey, kasb-hunar kollejlari va mustagil o rganuvchilar ham «Kompyuter

grafikasi va dizayn» fani mashg ulotlarini o rganishda foydalanishlari mumkin.
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